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1 General information

1.1 About this manual
This guide describes the IOT configuration by answering the following
questions:

e Introduction to IOT configuration with netPROXY: Add IOT functions
OPC UA or MQTT for products with netX firmware (or WebServer can
be added),

e installation and how to use ,

¢ Overview and step sequence for IOT configuration,

e Procedure for the IOT configuration based on a use case,

The procedure for IOT configuration recommended in this manual depends

on the order of the folders in the user interface of , which is based on the
principles of netPROXY.

On other questions about further manuals are available (see section
D:ﬂ references [ page 109]), for example, about the Web Builder [5].

1.11 List of revisions

Index Date Changes
1 18-11-29 |Created
Table 1: List of revisions

1.1.2 Online help

The program contains an integrated online help.
» Click View > Help or press F1, to access to the online help

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
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1.2 Conventions in this manual

Notes, instructions and results of operating steps are marked as follows:

Notes

Important:
<important note you must follow to avoid malfunction>

Note:
<general note>

<note where to find further information>

® e

Instructions
1. Operation purpose

2. Operation purpose
» Instruction

Results
2 Intermediate result

= Final result

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
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1.3 Legal notes

Copyright
© Hilscher Gesellschaft fur Systemautomation mbH
All rights reserved.

The images, photographs and texts in the accompanying materials (in the
form of a user's manual, operator's manual, Statement of Work document
and all other document types, support texts, documentation, etc.) are
protected by German and international copyright and by international trade
and protective provisions. Without the prior written consent, you do not
have permission to duplicate them either in full or in part using technical or
mechanical methods (print, photocopy or any other method), to edit them
using electronic systems or to transfer them. You are not permitted to make
changes to copyright notices, markings, trademarks or ownership
declarations. lllustrations are provided without taking the patent situation
into account. Any company names and product designations provided in
this document may be brands or trademarks by the corresponding owner
and may be protected under trademark, brand or patent law. Any form of
further use shall require the express consent from the relevant owner of the
rights.

Important notes

Utmost care wasl/is given in the preparation of the documentation at hand
consisting of a user's manual, operating manual and any other document
type and accompanying texts. However, errors cannot be ruled out.
Therefore, we cannot assume any guarantee or legal responsibility for
erroneous information or liability of any kind. You are hereby made aware
that descriptions found in the user's manual, the accompanying texts and
the documentation neither represent a guarantee nor any indication on
proper use as stipulated in the agreement or a promised attribute. It cannot
be ruled out that the user's manual, the accompanying texts and the
documentation do not completely match the described attributes, standards
or any other data for the delivered product. A warranty or guarantee with
respect to the correctness or accuracy of the information is not assumed.

We reserve the right to modify our products and the specifications for such
as well as the corresponding documentation in the form of a user's manual,
operating manual and/or any other document types and accompanying
texts at any time and without notice without being required to notify of said
modification. Changes shall be taken into account in future manuals and do
not represent an obligation of any kind, in particular there shall be no right
to have delivered documents revised. The manual delivered with the
product shall apply.

Under no circumstances shall Hilscher Gesellschaft flr Systemautomation
mbH be liable for direct, indirect, ancillary or subsequent damage, or for
any loss of income, which may arise after use of the information contained
herein.

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
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Liability disclaimer

The hardware and/or software was created and tested by Hilscher
Gesellschaft fur Systemautomation mbH with utmost care and is made
available as is. No warranty can be assumed for the performance or
flawlessness of the hardware and/or software under all application
conditions and scenarios and the work results achieved by the user when
using the hardware and/or software. Liability for any damage that may have
occurred as a result of using the hardware and/or software or the
corresponding documents shall be limited to an event involving willful intent
or a grossly negligent violation of a fundamental contractual obligation.
However, the right to assert damages due to a violation of a fundamental
contractual obligation shall be limited to contract-typical foreseeable
damage.

It is hereby expressly agreed upon in particular that any use or utilization of
the hardware and/or software in connection with

e Flight control systems in aviation and aerospace;

e Nuclear fusion processes in nuclear power plants;

¢ Medical devices used for life support and

e Vehicle control systems used in passenger transport

shall be excluded. Use of the hardware and/or software in any of the
following areas is strictly prohibited:

e For military purposes or in weaponry;

e For designing, engineering, maintaining or operating nuclear systems;

¢ Inflight safety systems, aviation and flight telecommunications systems;
¢ In life-support systems;

¢ |In systems in which any malfunction in the hardware and/or software
may result in physical injuries or fatalities.

You are hereby made aware that the hardware and/or software was not
created for use in hazardous environments, which require fail-safe control
mechanisms. Use of the hardware and/or software in this kind of
environment shall be at your own risk; any liability for damage or loss due
to impermissible use shall be excluded.

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
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Warranty

Hilscher Gesellschaft fir Systemautomation mbH hereby guarantees that
the software shall run without errors in accordance with the requirements
listed in the specifications and that there were no defects on the date of
acceptance. The warranty period shall be 12 months commencing as of the
date of acceptance or purchase (with express declaration or implied, by
customer's conclusive behavior, e.g. putting into operation permanently).

The warranty obligation for equipment (hardware) we produce is 36
months, calculated as of the date of delivery ex works. The aforementioned
provisions shall not apply if longer warranty periods are mandatory by law
pursuant to Section 438 (1.2) BGB, Section 479 (1) BGB and Section 634a
(1) BGB [Blrgerliches Gesetzbuch; German Civil Code] If, despite of all
due care taken, the delivered product should have a defect, which already
existed at the time of the transfer of risk, it shall be at our discretion to
either repair the product or to deliver a replacement product, subject to
timely notification of defect.

The warranty obligation shall not apply if the notification of defect is not
asserted promptly, if the purchaser or third party has tampered with the
products, if the defect is the result of natural wear, was caused by
unfavorable operating conditions or is due to violations against our
operating regulations or against rules of good electrical engineering
practice, or if our request to return the defective object is not promptly
complied with.

Costs of support, maintenance, customization and product care

Please be advised that any subsequent improvement shall only be free of
charge if a defect is found. Any form of technical support, maintenance and
customization is not a warranty service, but instead shall be charged extra.

Additional guarantees

Although the hardware and software was developed and tested in-depth
with greatest care, Hilscher Gesellschaft fir Systemautomation mbH shall
not assume any guarantee for the suitability thereof for any purpose that
was not confirmed in writing. No guarantee can be granted whereby the
hardware and software satisfies your requirements, or the use of the
hardware and/or software is uninterruptable or the hardware and/or
software is fault-free.

It cannot be guaranteed that patents and/or ownership privileges have not
been infringed upon or violated or that the products are free from third-party
influence. No additional guarantees or promises shall be made as to
whether the product is market current, free from deficiency in title, or can be
integrated or is usable for specific purposes, unless such guarantees or
promises are required under existing law and cannot be restricted.

Confidentiality

The customer hereby expressly acknowledges that this document contains
trade secrets, information protected by copyright and other patent and
ownership privileges as well as any related rights of Hilscher Gesellschaft
fur Systemautomation mbH. The customer agrees to treat as confidential all
of the information made available to customer by Hilscher Gesellschaft flr

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
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Systemautomation mbH and rights, which were disclosed by Hilscher
Gesellschaft flur Systemautomation mbH and that were made accessible as
well as the terms and conditions of this agreement itself.

The parties hereby agree to one another that the information that each
party receives from the other party respectively is and shall remain the
intellectual property of said other party, unless provided for otherwise in a
contractual agreement.

The customer must not allow any third party to become knowledgeable of
this expertise and shall only provide knowledge thereof to authorized users
as appropriate and necessary. Companies associated with the customer
shall not be deemed third parties. The customer must obligate authorized
users to confidentiality. The customer should only use the confidential
information in connection with the performances specified in this
agreement.

The customer must not use this confidential information to his own
advantage or for his own purposes or rather to the advantage or for the
purpose of a third party, nor must it be used for commercial purposes and
this confidential information must only be used to the extent provided for in
this agreement or otherwise to the extent as expressly authorized by the
disclosing party in written form. The customer has the right, subject to the
obligation to confidentiality, to disclose the terms and conditions of this
agreement directly to his legal and financial consultants as would be
required for the customer's normal business operation.

Export provisions

The delivered product (including technical data) is subject to the legal
export and/or import laws as well as any associated regulations of various
countries, especially such laws applicable in Germany and in the United
States. The products / hardware / software must not be exported into such
countries for which export is prohibited under US American export control
laws and its supplementary provisions. You hereby agree to strictly follow
the regulations and to yourself be responsible for observing them. You are
hereby made aware that you may be required to obtain governmental
approval to export, reexport or import the product.

Terms and conditions

Please read the notes about additional legal aspects on our netlOT web
site under http://www.netiot.com/netiot/netiot-edge/terms-and-

conditions/.

1.4 Registered trademarks

Windows® 7, Windows® 8 and Windows® 10 are registered trademarks of
the Microsoft Corporation.

All other brands mentioned are property of their relevant rights holder. Any
company names and product designations provided in this document may
be brands (company names or trademarks) of the corresponding owner
and may be protected under trademark or patent law.

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
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2 |OT functions OPC UA, MQTT

2.1 |OT functions with netPROXY

Real-Time Ethernet products for cyclic I/O data communication or for
acyclic communication work on the basis of a loadable firmware "Real-Time
Ethernet". The Real-Time Ethernet product already contains a developed
application that uses this cyclic or acyclic communication.

If this Real-Time Ethernet product is also to support IOT communication
with the OPC UA or MQTT protocols, this requires the use of an extended
loadable firmware. In addition, an integrated WebServer can be used for
the product.

The IOT functions OPC UA or MQTT can be configured or WebServer can

be added with the help of . This extension is based on netPROXY. The
necessary configuration steps are described in this document. The already
developed application can be extended and use data communication via an
IOT protocol.

netPROXY object model

netPROXY is an object-oriented data model and provides a protocol-
independent application program interface (API) for accessing the objects.

The netPROXY object model allows to map device properties to objects.
Each object and thus the device properties defined in the object are
identified by an ID. For each object, the user can take settings on how to
access to the object and how to process the object data.

On the top level the netPROXY object model includes the object ID,
followed by the instance ID and the element ID. Together these three levels
characterize an object. The instance ID specifies the occurrancy frequency
of each object. The element ID contains the actual value of the device
property defined in the object. Several objects are combined to build a
group by a group ID.

Application example for IOT configuration

For example, an operating hours counter is assigned to an object via an
object ID. The instance ID indicates how often an operating hours counter
occurs: operating hours counter 1, operating hours counter 2, etc. The
number of operating hours is stored in an element as "Status", or settings
could be stored in an element as "Parameters".

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
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Specification for the IOT configuration

The following use cases are conceivable:

e Configuring OPC UA

e Configuring MQTT

Configuring OPC UA and/or MQTT

If necessary, additionally configure WebServer

Object properties and functions

In the net PROXY object model every object has properties and functions.
A property is characterized by a value, a parameter and a communication
attribute.

Value

Parameter
Communication attribute (communication path)
Table 2: Identification of object properties.

An object can include the functions Create, Read, Write, and Delete.

Create

Read

Write

Delete

Table 3: Object functions

The objects properties and functions are given to the object by help of the .

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
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2.2 communication channels

The following graphic gives an overview of the communication between the
application and the network. In addition to cyclic and acyclic communication
and Ethernet communication to the real-time Ethernet master, this includes
IOT communication with OPC UA or MQTT from the object to the
application or to the network. In addition, an integrated WebServer can be
used.

A AppllcaAtlon A
Host intefface
Channel [0 Channel|1 CGhannel|2
¥ ¥
Input Output | Mailbox | Mailbox Mailbox | Mailbox Mailbox | Mailbox

netX Processor / Firmware

Communication / Network

communi- | communi- Ethernet
cation cation

cyklic acyclic

(*mapped

Real-Time
Ethernet Master

via label)

PC + web browser
MQTT broker

Ethernet OPC UA client
Communication channels 1to N

Figure 1: netX Studio Engineering Tool IOT - communication channels

The data transfer between application and communication / network is
performed in netX by the device firmware with 10T functions (shown in dark
gray) according to the valid configuration and the settings.

In IOT communication, data flows from the object to the network or vice
versa via:

— OPC UA*

- MQTT*

— WebServer**

*IOT function, **additional WebServer function

The objects with the communication attribute None can be assigned to
OPC UA, MQTT or WebServer via labels. Further information on how to
configure access to objects in the object definition can be found in the
section Access to object data [ page 26].

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
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Component Description
Application Cyclic communication:
program

o Input data of the application: The application reads cyclic data from the network.

o Output data of the application: The application writes cyclic output data to the network.
Acyclic communication:

e The application processes the acyclic communication.

Ethernet communication

e The application processes the Ethernet communication.

Access to IOT objects:

e The application reads data from the objects received from the network via OPC UA, MQTT or
WebServer.

e The application writes data to the objects and this data is sent to the network via OPC UA, MQTT
or WebServer.

Host interface

Channel 0: Input or output for cyclic and acyclic Real-Time Ethernet communication
Channel 1: Mailboxes for standard Ethernet communication
Channel 3: Protocol-independent host interface for netPROXY

The host interface for netPROXY can be e. g. a serial or a parallel dual-port memory (DPM) based
on SPI. Components are mailboxes.

Object dictionary in
the netPROXY part

List of objects structured according to the netPROXY data model
Via the objects individual device properties are provided.

The basic netPROXY data model is independent of the later used communication protocol or the
connected hardware.

Communication /
network

Hardware-dependent communication interface or connection to the network via the communication
channels 1 ... N.

e The cyclic, the acyclic and the Ethernet communication to the master are available as
components of the netX firmware.

o Communication via OPC UA, MQTT or WebServer can also be used by the application.

Object data

Objects can be read or written via OPC UA, MQTT and WebServer.
OPC UA, MQTT and WebServer represent an "application" from the point of view of the objects.

Communication
paths

Communication takes place from the application to the network or from the network to the
application.

More details can be found in the here following section and in the section Access to object
data [ page 26].

Table 4: Components netX firmware with IOT

netX Studio Engineering Tooll | IOT Configuration
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2.3 Labels
Access to the object data is configured via labels. Labels define access to
the object data to/from the network
— OPC UA,
— MQTT and
— WebServer.
The application accesses the object data via the mailbox.
When defining the objects, it is determined on which communication paths
the firmware should transfer the device properties provided by the objects.
Communication attribute "None"
Note:
For the 10T configuration of netX-Fimware products, the objects
have the communication attribute None as default, since the input
and output data are not mapped via netPROXY.
netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018

DOC1804040I01EN | Revision 1 | English | 2018-11 | Released | Public



netX Studio Engineering Tool 15/115

3 netX Studio Engineering Tool

3.1  About the tool

The is an Eclipse-based tool which can be used for products with netX
firmware to configure IOT communication, especially for the following
purposes:

e Object configuration (creating and managing objects),
e Configuration for OPC UA and MQTT,
e User rights and web content settings,

e Build process of the IOT communication (creating product files, with
object configuration and all settings of the IOT protocols),

3.1.1 Scope of application

The scope of application of the is limited to slave devices based on netX,
which operate with a loadable firmware. The tool is mainly used for Real-
Time Ethernet systems.

3.1.2 Basic and engineering version
can be obtained as a free basic version with limited functionality. For the full
version, you must purchase a license. The two versions differ as follows:
¢ netX Studio (netPROXY Basic) allows you to configure
— one application variant and
— one communication protocol (network).
¢ netX Studio (netPROXY Engineering) allows you to configure
— as many application variants as required and
— all available communication protocols (networks).

3.1.3 System requirements

e PC with standard equipment (monitor, keyboard, mouse, DVD drive,
optionally USB port etc.)

e Windows® 7 (32-Bit) SP1, Windows® 7 (64-Bit) SP1, Windows® 8 (32-
Bit), Windows® 8 (64-Bit) or Windows® 10 (64-Bit)

3.14 Requirements

) Note:
. To be able to connect a device via USB (USB/RS232) to , there
must be no other serial connection to the device.

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
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3.2 Installation

In the following sections you find descriptions on how to install or uninstall
the program under Windows® 7, Windows® 8 or under Windows® 10 to your
PC.

Requirements and notes

You need the installation file nxsbuilder-win32.win32.x86.msi.

) Note:
. Close all programs on your PC, before installing or uninstalling. You
also need administrator privileges under Windows®.

If an earlier program version is already installed on your PC, first
uninstall this version before you install the current version.

Files and folders created by the user are not deleted during
uninstalling the program.

3.2.1 Installation steps
» Double click on the installation file.
> The installation is started.
» Click Next.

8 netX Studio V Setup

Welcome to the netX Studio
\ Setup Wizard

The Setup Wizard will install netX Studio V on
your computer, Click Next to continue or Cancel to exit the
Setup Wizard.

Figure 2: Installation information (example Windows® 10)

» Check | accept the terms in the License Agreement.

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
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ﬁ netX Studio V Setup - *
End-User License Agreement f
Please read the following license agreement carefully L Eh =
SREEIIERGN
HILSCHER S0OFTWARE LICENSE AGREEMENT ~

This document is a legal Agreement between you, the
license, and Hilscher Gesellschaft fur
systemautomation mbH, ("Hilscher"). Please read this
Agreement carefully before you install the software.
By installing or otherwise using the software, you
accept the terms of this Agreement. If you do not
agree to the terms of this Agreement, then do not
install or use the software, return it to us or to
the distributor from which you have it purchased for
a full refund.

1. Copyright v

[ gecept the terms in the License Agreement!

Print Back Cancel

Figure 3: Accepting end user license agreement (example Windows® 10)

> Click Next.

#2 netX Studio V Setup - X
Destination Folder —
Click Next to install to the default folder or dick Change to choose another. salEn
Conemeremes W
Install netX Studio v to:

|C: \Program Files (x86)Hilscher GmbH\netX Studio

Change...

Figure 4: Installation target folder (example Windows® 10)

» Select a target folder.

8 netX Studio V Setup - X

Ready to install netX Studio V. mam Lm f

CoremETENOE
RS ]

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back ] Install ] Cancel

Figure 5: Performing installation (example Windows® 10)

> Click Install.

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
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) netX Studio V Setup — X

Installing netX Studio Vi

i} |.
H

Please wait while the Setup Wizard installs net Studio W

Status: || _|
|

Figure 6: Installation progress (example Windows® 10)
2 A Windows® safety request is displayed.
» Click Yes.

2 The components are installed. This takes a few minutes.
» Click Finish.

8 netX Studio V Setup

Completed the netX Studio
\ Setup Wizard

Click the Finish button to exit the Setup Wizard.

H?‘E ¢hip

et

Figure 7: Installation completed (example Windows® 10)

= The installation is complete.

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
DOC1804040I01EN | Revision 1 | English | 2018-11 | Released | Public



netX Studio Engineering Tool 19/115

3.2.2 How to uninstall
> Open the Windows® Uninstall or change programs menu window.
> Right click on the netX Studio VX. XXXX.XXXXX entry.
» Click Uninstall.
2 The safety request appears asking if you want to uninstall netX Studio.
» Click Yes.
2 The Windows Installer prepares the uninstallation.

net¥ Studio W

] Preparing to remove ...
i!;\—-"
¥,

Figure 8: Preparing to uninstall (example Windows® 10)

A Windows® safety request is displayed.
Click Yes.
The components are uninstalled. This takes a few minutes.

gV I

net¥ Studio V

_IZ[ Please wait while Windows configures netX Studio VI 00

Time remaining: 3 seconds

I Cancel

Figure 9: Progress indicator for uninstalling (example Windows® 10)

= The uninstallation is completed. The program was removed from your
PC.
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3.3 Description

3.3.1 Starting program and creating project

9 Note:
. The device development with is an offline process. A connection to
a device is not required.

> To start, click Start > netX Studio.
= The program opens with the Welcome start screen.

In the basic version netX Studio (net PROXY Basic) in addition the
message appears:

The free "netPROXY Basic" version of netX Studio limits the device configuration to:
¢ one object model (Application)
e one communication protocol (Communication Settings).

For the unlimited "netPROXY Engineering" version please contact Hilscher GmbH Sales at
http://wwww.hilscher.com/en/sales/sales-contact/.

- o x
File Edit Wiew Project Fun Wind o Help
[ y FE A

% Welcome

Welcome to netX Development with Eclipse

L2

"ot Create a new netIC project Help Contents

@CR The free "netPROXY Basic” version of netX Studio limits the device configuration to:
@ » One object model (Application);
» One communication protocol (Communication Settings).
For the unlimited "netPROXY Engineering” version please contact Hilscher GmbH at
nttp:/fwwwhilscher.com/en/sales/sales-contact i

[] Do not show this message again.

"#* netlC for EtherNet/TP network with MQTT, OPC UA and Web Server support

"$* netlC for PROFINET IO network

.
8% netlC for PROFINET IO network with MQTT, OPC UA and Web Server support ’

%t netXIoT configuration with MOTT hil@@l}n(@ﬁ]

"% netX IoT configuration with OPC UA COMPETENCE IN
COMMUNICATION

netX Studio Basic
Figure 10: Home screen netX Studio (net PROXY Basic) with message box

» Confirm the message with OK.

In the full version netX Studio (netPROXY Engineering) the home screen
appears without a message.
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File Edit View Project Run Window Help
i F &8

Workbench

Welcome to netX Development with Eclipse

L)

" Create a new netlC project Help Contents
%+ Create a new net¥IoT project

"** Open existing netX Studio project

% netlC for EtherMet/IP network

4 netlC for EtherMet/IP network with MQTT, OPC UA and Web Server support

% netlC for PROFINET IO network

A
** netlC for PROFINET IO network with MQTT, OPC UA and Web Server support ‘

o
' netXIoT configuration with MQTT hl I@@I}D@I}]

# netXIoT configuration with OPC UA COMPETENCE IN
COMMUNICATION

Figure 11: Home screen netX Studio (netPROXY Enigneering)

On the home screen, you can create a project. If you do not close your
project before you quit the program, the project is automatically displayed
at the next program start.

Creating project

» To create a project, click File > New > New netX loT project ... (or on
the Welcome tab Start > Create a new netX loT project).

View  Project  Run  Window  Help
New 0 % New nefIC Project

Open Project/Solution u &w an IoT Project -
Clase Solution amples

Clase Crl i

Figure 12: Creating a new project

2 The New netX loT Project window opens:
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New netXToT Project = B &
New netX IoT Project
Choose the name and location of the netX IeT Project.

Project name: ™

Location:  C:\Users? net¥ Projects', Browse...

®

Figure 13: Enter project name and storage path
Under Project Name* (mandatory field) type a project name.

Set under Location the storage path for your project and click OK.
The project is created.

0 Important:
Note that applies all the settings and changes in your project

automatically into the project file.

3.3.2 Opening and closing project

Open project

>
>
=N
>

>
=

To open a project in, click File > Open Project / Solution.
Or select on the Welcome tab Start > Open existing netX loT project.
The Open window appears.

Select the file .project (type: PROJECT file) or the file .solproject
(type: SOLPROJECT file).

Click Open.
The project opens.

) Note:
. Note that in the basic version of "netX Studio (netPROXY Basic)"

you only can access to projects, the configuration of which is limited
to one application variant and one communication protocol
(network).

Close project

>
=

To close a project in, click File > Close Solution.
The project is closed.
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3.3.3 Graphical user interface

The following figure shows the graphical user interface of with the opened
project:

File Edit View Project Window Help
0 -EER
[ Project Explorer &2
B%
4 [ netX_|OT_project
» fm Object Model:
& & Communication Settings
¢ & Product Details
& & Vendor Details

> &5 User Management
b & Web Builder

i@ Object Definitions 32

LIDvazv|E T

type filter text & Console 2

» B Object Definitions netX Studio

0 items selected

Figure 14: graphical user interface with opened project

Main components

The graphical user interface of the program is divided into:
e the menu,

e the toolbar and

¢ the movable windows:

— Project Explorer and editor (the shown content depends from the
selected folder),

— Object Definitions, Console and Alerts.

Note:

. To perform the IOT configuration correctly, you have to go through
the folder structure down from the top in the Project Explorer
window. Finally, the build process is performed.

Icons and dialogs

There are also the icons to handle the program which are arranged in the
single windows, or dialogs that appear during the different steps for the 10T
configuration. A description of the icons is given in the respective tooltip.
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Further information

be found in the descriptions of the IOT configuration steps in the

A description of the various program components and controls can
chapter IOT configuration [ page 34].

3.3.3.1 Toolbar

The toolbar contains icons to access different program options.

Run Window Help

Figure 15: Toolbar (activated)

Icon Name Menu path Meaning For more information, see section
] New File > New > Create new project Starting program and creating
Project New Project project [ page 20]
Save File > Save Disabled in -

Save as File > Save as

ol Build Project > Build Start build process Build process [ page 88]
I Connect Run > Connect Establish online connection to | Without function.
the device
g Disconnect | Run > Disconnect |Disconnect online connection
to the device
Q»" Search - Standard search functions in -

Eclipse
Table 5: Icons in the toolbar

Open example projects

Edit

View Project Run Window Help
‘ot New netlC Project

ot New netX IoT Project

Open Project/Solution .
"o+ New netlC project example for EtherNet/IP network

‘ot New netlC project example for EtherNet/IP network with MQTT, OPC UA and Web Server support
"ot New netlC project example for PROFINET IO network

ot New netlC project example for PROFINET IO network with MQTT, OPC UA and Web Server support
ot New neti IoT project example with MQTT

‘ot New neti IoT project example with OPC UA

Close Solution

Open File..

Clase Crl +4i

Save Crl+35

Save A3

Figure 16: Menu new project

You can open example projects viaFile > New > Examples >
¢ New netX loT project example with MQTT,

e New netX loT project example with OPC UA.
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3.3.3.2 General controls

In the table below you can find explanations of controls that repeatedly
appear in in various dialogues.

Parameters Meaning

Filter [type filter text] Field to type a filter text.

ype liler text

® Open help information.

A step back.

[ hea> ] Proceed a step.

CEnish ] Completing the current step.
[ Concel ] Cancel the operation.

Table 6: General controls
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3.4 Access to object data

In you can configure how the object data is to be accessed for IOT
communication via OPC UA or MQTT.

OPC UA, MQTT, WebServer

Access to object data via OPC UA, MQTT or WebServer is configured by
assigning labels at object level.

Data mapping at the object level

The communication via OPC UA, MQTT or WebServer is configured at
object level. This allows access to the data of all elements of an object for
the respective communication path.

Object Definitions editor and Communication Settings
In the configuration of the access options to the object data for OPC UA,
MQTT or WebServer is done in the following way

— with the object definition in the Object Definitions editor, by
assigning labels on the object level,

— with the communication settings under Communication Settings,
by supplementing the respective editor or reassigning labels in it and
performing the corresponding configuration.

Combinations of different access paths to object data

0 Important:

The access options to object data via OPC UA, MQTT and
WebServer can be combined in different ways. However, OPC UA
and MQTT may not be used simultaneously in the communication
settings for the same application variant.

0 Important:
An object or element may only be written by one user (master, OPC
client etc.).

An object or element can be read by multiple users.
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3.4.1 Examples

The table Object data by access configuration (examples) shows examples
of possible combinations of different access paths from the network to
object data. Considered are the possibilities on how to access OPC UA,

MQTT and WebServer.

Object data* Communication Label
attribute OPC UA|MQTT |[WebServ

e Object data, to be accessed from the WebServer. None - - WWW

e Object data, to be accessed from the OPC UA server. None OPC UA - -

e Object data, to be accessed from the OPC UA server and None OPC UA - OPC UA
additionally from the WebServer.

e Object data, to be accessed via MQTT. None - MQTT -

e Object data, to be accessed via MQTT and additionally None - MQTT MQTT
from the WebServer.

Table 7: Object data by access configuration (examples)

* To all the data referred in the Object data column, the application has

read and write access.
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4 Overview of the IOT configuration

The goal of the IOT configuration is to extend products with netX firmware
by the IOT functions OPC UA or MQTT. Based on netPROXY an integrated
WebServer can be added.

4.1 Create project configuration and specify IOT configuration

As a preparatory step for the mapping of the device properties in objects
and the 10T configuration with a listing of the existing functionality, the
device properties or the device design and the specification of the IOT
configuration of the products to be configured is required (in the example
used, 'netX_|OT_project' with the Example device 'C100").

Proceed as follows:

e Design of the products and the products family

» For the products (or product family) for which IOT functions are to be
added, compile a list of existing functions, device properties or device
design.

¢ Definition of the properties and the assignment to object
categories

» Specify object categories (possibly with ID ranges) and objects to map
the device properties.

The object categories are used to structure the objects in a way that makes

sense.

» Set the object identifiers, object names and the assignment of objects to
categories.

Also consider the standard objects available in .

e Access to the objects via the network

» Specify the 10T functions to be supplemented (OPC UA or MQTT) or
the WebServer function if necessary, and define the required
communication paths (OPC UA or MQTT, or WebServer).

e Creation of elements

» Specify which elements you require for the individual objects, that is,
whether, for example, elements still need to be created for parameters.
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4.2 Offline operation and requirements

4.3 Steps on how to proceed

The 10T configuration with including the build process is performed offline.
A connection to a device is not required.

The following table shows an overview of the IOT configuration,
commissioning or test.

product files

configuration) to the device using the
host application.

Task Step [Description Menu or folder in netX |For more information
Studio Engineering see section
Tool
IOT configuration |1.1 Creating project File > New > New Starting program and
(offline process) Project ... creating
project [ page 20]
1.2 Creating object Object Model / Object Creating
Definitions / User objects [ page 34]
1.3 Using standard objects Object Model / Object Using standard
Definitions / Standard objects [ page 51]
1.4 Configuring application variant Object Model / Object Configuring application
(scope of functions) Instances variant (scope of
functions)
1.5 Performing communication settings | Communication Settings |Performing
communication settings
1.6 Configuring product details Product Details Configuring product
details [ page 75]
1.7 Typing vendor details Vendor Details Entering vendor
information [ page 82]
1.8 Configuring user managment User Management Configuring user
managment [ page 84]
1.9 Creating and managing web content | Web Builder Creating and managing
web content [ page 88]
1.10 Creating product files Product Build Generating product
files [ page 88]
Loading the 21 Transfer product files (with the - Downloading product

files [ page 94]

Table 8: Step sequence during project configuration or IOT configuration
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4.3.1 Explaining the steps

The following section provides explanations of the project configuration
steps for mapping the existing products and 10T configuration in .

Project configuration and additional IOT configuration (offline
process)

e Step 1.1: Creating a project
» Create a new project.
o Step 1.2: Creating object

» Specify the functionality, including device properties, for the products
with the IOT functions.

» Specify the 10T functions to be added.

» Define the objects and the access to the objects and how they are
mapped to the network.

Communication to the network can be established via OPC UA or MQTT,

or additionally via WebServer.

o Step 1.3: Using standard objects

offers the option of using predefined standard objects at object definition

level. An assignment of the standard objects to OPC UA Client, MQTT or

WebServer is not set up by default and can only be configured manually (if
necessary).

o Step 1.4: Configuring application variant (scope of functions)

» Use the listin step 1.3 to clarify the product classification to be mapped,
the range of functions available or the device properties.

» Based on the objects defined in step 1.3, configure the functionality for
the products intended for IOT configuration.

9 Note:
. Note that in the basic version of "netX Studio (netPROXY Basic)"
you can only configure one application variant (Application).

e Step 1.5: Making communication settings (IOT configuration)

» Make the necessary communication settings to configure access to
object data via OPC UA, MQTT or WebServer.

e Step 1.6: Configuring product details
» For each device type set a folder for the product details.

» Configure the product data for hardware, firmware and for the boot
loader, and the data for product identification and versioning of each
single device.

o Step 1.7: Typing vendor information
e Step 1.9: Configuring user management
e Step 1.9: Creating and managing web content

in separate documentation (see section References [ page 109]).

Information on user administration and the WebServer can be found
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e Step 1.10 Generating product files
» Start the build process for the device to create the product files with the
configuration.

The product files contain the object definition and the IOT configuration as
well as all settings for the product.

Loading the product files

e Step 2.1: Load product files with the configuration into the device

» Load all product files created with the build under Product Build >
Products > Product (Application) into the device using netHOST.exe
or the host application.
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432 Labels and communication settings for OPC UA, MQTT or
WebServer

This section provides an overview of the basic procedure for configuring
access to the object data using labels or communication settings for OPC
UA, MQTT or WebServer.

Preparation and requirements

First, create a schema on how to access the object data required for your
product or to which objects is to be accessed to.

0 Important:
1. An object or element may only be written by one user (master,
OPC client, etc.).

2. An object or element can be read by multiple users.

Principal steps in
1. With the object definition assign one or more labels on object level.

» In the Object Definitions editor via Assign label assign a label to the
object, see section Specifying object properties [ page 43] and/or

2. Configure the communication settings for OPC UA, MQTT or WebServer
(Communication Settings), see section Adding OPC UA, MQTT or
WebServer [ page 65].

» OPC UA: Configure in the OPC UA editor the access via the OPC UA
server to object data.

» OPC UA: In the OPC UA editor, define which objects are to be
displayed via the OPC UA server.
Note: Objects for which access is configured from the WebServer, can
be displayed simultaneously via the OPC UA server.

» MQTT: Configure in the MQTT editor the access via MQTT to object
data.

» MQTT: In the MQTT editor, specify which objects are to be displayed
using MQTT.
Note: Objects for which access is configured from the WebServer, can
be displayed simultaneously via MQTT.

» WebServer: Specify in the WebServer editor, which objects are to be
displayed via WebServer.
Note: Objects, for which an access from the OPC UA server or via
MQTT is configured, can be displayed simultaneously via WebServer.
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4.3.3 Example C100

The example used in this manual includes the C100 product with a counter
and a parameter object.

Object data for the example C100

The product used in the C100 example has the function of an operating
hours counter and contains a parameter object.

Object identifier Object name
0x40010001 Counter
0x40020001 Parameter

Table 9: Object data for the example C100

Application variants for the example C100

In the example, the existing product C100 is mapped with a counter and a
parameter object (see table Range of functions, example

C100 [ page 55]). For the product C100 the operating hours counter
'‘Counter’ records the operating hours, while in object 'Parameter' settings
can be made.

Communication settings for the example C100

In the example, the communication settings for OPC UA, MQTT and
WebServer are added for the product C100.
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5 10T configuration

To configure IOT, you must create a project for your product, create objects
in it, and set IOT parameters.

5.1 Creating objects

To map the device properties in to objects, the following main steps are
required:

e Generate for all device properties the categories, the objects and the
elements of the objects, so that all device properties are mapped to the
created objects.

¢ Define the access to the objects or elements and their mapping to the
application and to the network.

In the following sections you will find a step by step description on how to
proceed.
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5.1.1 Creating category

» To create a category, in the Project Explorer window right-click on
Object Model > Object Definitions > User.

[t5 Project Explorer &2

4 [ netX_IOT_project
4 & Object Model
4 EF Object Definitions

B User
gt gt G MNewObject  Alt+O

& Obje
&= Commu B Export Ctrl+Alt+E
& Product) &Import Ctrl+ Alt+1
> &= Vendor Detalls
» &% User Management
> 4% Web Builder
Figure 17: Project Explorer - New Category

Click New Category.
The dialog box Create New Category appears.

Under Category name* (mandatory field), type the name for the
category.

vV J VvV

[ — x
Create New Category
Enter category details.

Category name: * Status|
+ Advanced

CED CZID

Figure 18: Create New Category

> Click OK.
= The folder for the category is displayed (in the example Input data).

In the same way you can also create additional subcategories.
» Also create output data (Output Data in the example).

Categories with ID ranges (Advanced)

When you create a category, to reserve object IDs for future extensions,
you can define your own ID range for the objects of this category. supports
managing object IDs. All object IDs of the objects in the corresponding
category are then within this range.

» Click Advanced.

» The Create New Category dialog box with the additional input fields for
the ID range appears.

» Under Category name* (mandatory field), type the name for the
category.
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Create New Category x
Create New Category
Enter category details.

Category name: ™ Status

 Advanced

Object ID range from:  0:40010001 to 0x40010010]

D CCID

Figure 19: Create New Category — Advanced

» Under Object ID range from (lower limit) or to (upper limit), specify an
ID range for the objects of the category.

) Note:

. The range limits 0x40000000 to Ox4FFFFFFF are valid. The start ID
and the end ID must be within these limits. The start ID must be
less than the end ID, otherwise an error message will appear.

> Click OK.

= The folder for the category is displayed (in the example Input data). In
addition, the defined ID range appears.

Details on categories with ID ranges can be found in the section /D
EE range for category [ page 37].

Rename, Remove (rename or remove category)

» To change the name of a category or to remove the category, right-click
in the Project Explorer window on a folder of a category (in the
example Input data or Output data).

> Click Rename or Remove.
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51.1.1 ID range for category

With the full version of netX Studio (netPROXY Engineering), you can
assign objects to categories and in addition you can assign objects to
defined ID ranges and thereby group them. Fot this the following is valid:

Optionally, an ID range can be set for each category, which is valid for
objects assigned to the category. The range limits 0x40000000 to
Ox4FFFFFFF are valid and the start ID must be less than the end ID.

If an ID range changes, all object IDs of the objects assigned to a
category must still be within that ID range.

To a category with a defined ID range only objects can be assigned the
object ID of which is within this ID range.

For object categories with ID ranges, each object created in a category
receives an object ID directly in the ID range defined for this category.

Two or more categories can have identical or overlapping ID ranges.
The object ID remains unique because it can only be used once.

IP ranges of subcategories are not related to the ID range of the main
category and may be outside the ID range of the main category.

An object can only be moved to a category if its object ID is within the
ID range of the target category.

A category with an ID range can only be imported if it does not contain
objects with IDs outside the ID range of the target category. During the
import, the existing structure is replaced by the imported structure.

Assigning objects to defined ID ranges
» To create an ID range for a category, right-click Object Model > Object

Definitions > User > [Name of category] in the Project Explorer
window.

[ Project Explorer 32 BES - =&

s % netX_|IOT_project
4 5 Object Model
4 k5 Object Definitions

4 K& User
4 | Paramefer
. @ x40l (& MNew Object Alt+0
4 B= Status New Category Ctr|+5h|f-t+C
o ] [}x4[}|
> B Standard | # Rename F2
> s Object Instang % Remove Delete
> = Communication | B Export Ctrle Alt<E
> B Product Details Import Ctrls Alt+]

> B Vendor Details
> 24 User Management
> 25 Web Builder

Figure 20: Contextmenu ID range

» Click to ID range.
» The dialogbox Edit Category Object ID Range appears.
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Edit Category Object ID Range

Enter the minimum and maximum value of Object IDs in this category.

Object ID range from: 040010001 to Ux4UUlUUlU‘

® D CTID

Figure 21: Edit Category Object ID Range

» Under Object ID range from (lower limit) or to (upper limit), specify an
ID range for the objects of the category.

9 Note:

. The range limits 0x40000000 to Ox4FFFFFFF are valid and the start
ID must be less than the end ID, otherwise an error message will
appear.

> Click OK.

2 The defined ID ranges (shown in blue in the image) appear in the folder
for the category (in the example Input data or Output data).

[t5 Project Explorer 22 BES - =

4 [ netX_|OT_project
4 i Object Model
4 £ Object Definitions
4 & User
F &= Parameter [0x40020001 - [})(4[}[}2[}[}1[}”
@ 0x40020001 Parameter [1.0]
|‘ = Status [0x40010001 - 0x40010010] |
® 0x40010002 Counter [1.0]
> & Standard

Figure 22: Example of overlapping ID ranges

Importing or exporting categories with defined ID ranges

Categories with defined ID ranges can be imported or exported via File >
Import or Export or via the Import or Export context menu of a category.
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5.1.2 Creating object
You can create objects directly in the Object Definitions folder or in a
folder of a category or subcategory.

» To create an object, right-click in the Project Explorer window on a
folder of a category (in the example Input data or Output data).

[ Project Explorer 2 BES ~- =
4 [ netX |OT project
4 5 Object Model

4 Es2 Object Definitions

4 G User
&= Parameter
= Status
. s Standan 1i,. New Object
- Bs Object Inst I-[‘I‘New Category  Ctrl+Shift+C
. B Communicatig "9 Ctrl+-Alt+R
> B Product Detail # Rename F2
> &= Vendor Details % Remove Delete

1]
> &4 User Manage B Export Ctrl+Alt+E

> & Web Builder | g mport Ctrl+Alt+1

Figure 23: Project Explorer - New Object

» Click New Object.
2 The dialog box New Object opens.

Create Object Definition
Enter object name and category.

Object identifier: * 040010001

Object name: * |

Object categories:

4 Faf User Object Definitions
& Status
B Parameter

[] Open in object editor

®

Figure 24: Creating new object

Parameters Meaning Range of
value/value

Object identifier* | Each object is uniquely identifiable by its object identifier (object ID). The 0x40000000
(mandatory field) [object identifier is assigned as a consecutive number, no matter whetheran | ...
object was created by using the New Object dialog or by copying. Ox4FFFFFFF

If an object is created within a category with a defined ID range, each object
created in this category automatically gets an object ID from the ID range
defined for the category. In the case of manual assignment, only object IDs
within the defined ID range can be selected. See also section ID range for
category [ page 37].

Object name* Object name 3...50
(mandatory field) characters
Object Objects can be assigned to a category and thereby are combined.

categories

(optional)

Table 10: New object — parameters
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0 Important:

The object identifier (Object identifier*) can only be adapted in the
New Object window. The object identifier (Object identifier*)
cannot be changed later.

If an object has been assigned to a category (Object categories) in
the New Object window once, this assignment may not be changed
later.

In the example B100, B150, the specification was made: object identifiers
for sensors: 0x4001xxxx object identifiers for actuators: 0x4002xxxx

» Enter the object identifier (in the example for the 'Counter' object
0x40010001 and for the 'Parameter’ object 0x40020001).

» Add the object name in the mandatory field Object name*.
» Under Object categories select the object category.

Create Object Definition
Enter ohject name and category.

Object identifier: * 040010001

Object name: * Counter

Object categories:
4 M8 User Object Definitions
& Status
& Parameter

[7] Open in object editor

® ca
Figure 25: Adapting object identifier, typing object name, selecting object category
» Click OK.

[ Project Explorer &2

4 (1% net_|OT_project
4 I Object Model
4 |5 Object Definitions
4 [ User
&= Parameter
4 5 Status
# 0x40010001 Counter [1.0]
> & Standard
> = Object Instances
> B Communication Settings
> B Product Details
> B Vendor Details
> =4 User Management
» &2 Web Builder

Figure 26: Example object '0x40010000 Sensor - simple [1.0]'

= You have created an object (in the example 0x40010001 Counter).

Information about how to create an object by copying and pasting or how to
rename or remove an object, see section Copying and pasting object,
renaming, removing [ page 41]. It often makes sense to first create the
elements of an object and then copy the object afterwards.
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51.2.1 Copying and pasting object, renaming, removing

Copy (copying object)
» To copy an object, right-click in the Project Explorer window on an
object folder (in this example 0x40010001 Counter).

[ Project Explorer & BS ~- =

4 [ netX_IOT_project
4 & Object Model
4 B Object Definitions

4 B User
> B Parameter
4 & Status
4| ®» 0x40010001 Count
#+ Counter1 e . S
& Counter2 #Rename  F2

» Fas Standard ¥ Remove Delete

> B Object Instances
> B Communication Settings
> B Product Details
» &= Vendor Details
> &% User Management
> #2 Web Builder

Figure 27: Copy (copying object)

» Click Copy.
= The object is copied to the clipboard.

Paste (pasting object)

» To add an object, right-click on the folder to which you want to add the
object and click Paste.

[25 Project Explorer & BES &

4 [ netX_|OT_project
4 B Object Model
4 B Object Definitions

4 [ User
> s Parameter
4| Statu
4 @ Oxd @ New Object Alt+0
- Bt Mew Category  Ctrl+Shift+C
- IDID range Ctrl+Alt+R
- 2 Standarc RIS
> i Object Inste  pename 2
> B Communicatio| y Remove Delete
> B Product Detail
- &5 Vendor Details £ 5ot Ctrl-Alt-E
. 2 User Managerr ZlImport Ctrl+Alt+]

> &2 Web Builder
Figure 28: Paste (pasting object)

= The object is inserted at this position.

allows you to copy objects, including elements therein created. If
necessary, first create an object with its elements and then generate
therefrom further object variants.
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0 Important:

Note that when creating an object by Copy and Paste, always
assigns the object identifiers Object identifier* with a consecutive
number, starting from 0x40000000. The object identifier cannot be
changed.

If the object identifier should be assigned according to additional rules
(systematic assignment of identifiers for objects of certain categories, e.g.:
0x4001XXXX or 0x4002XXXX), each object is to be created manually using
the command New Object and the New Object window.

Rename (renaming object)

» To change the name of an object, right-click in the Project Explorer
window on an object folder (in this example 0x40010001 Counter).

» Click Rename.

> The Rename window appears.

» Type the new object name to the Enter new Name field and click OK.
= The object folder appears with the changed name.

Remove (removing object)

» To remove an object, right-click in the Project Explorer window on an
object folder (in this example 0x40010001 Counter).

» Click Remove.
» Confirm the question whether you want to remove the object with OK.
= The object gets removed.
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5.1.3 Specifying object properties

» Double click on Object Model > Object Definitions > User and on the
object folder (in example 0x40010001 Counter [1.0]).

2 In the editor the tab for the object appears, with the subareas
Properties and Elements.

It5 Project Explorer &2 ® 0x40010002 - Counter &2

4 [ netX_|OT_project

4 B Object Model =¥ 0x40010002 - Counter @
4 K& Object Definitions
a1 User ~  Properties
> &= Parameter [0x40020001 - 0x40020010]
4 B& Status [0x40010001 - 0x40010010] Identifier 0x40010001

* 0x40010001 Counter [1.0]
> & Standard
> &= Object Instances . Description
» I Communication Settings

Name Counter

Version 1.0
» f Product Details
> &= Vendor Details Type name’ COUNTER
» &5 User Management Labels:
» & Web Builder
» = Product Build
~  Elements Value display mode: M -

type filter text

> B Object Definitions

Ii§ Object Definitions 52 # Element.. ¢ Variable .. # DataType Count ¢ Default Value  Attributes ¢ Description m

Figure 29: Editor with Properties and Elements - example

The values for Identifier, Name, Version and Type name, indicated under
Properties, are automatically generated or from the data given in the New
Object window. The object identifier Identifier cannot be changed here.

» Adapt the parameters under Properties.
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Assign labels

Via Assign label you can create any labels yourself and assign one or
more labels to an object. The labels OPC UA, MQTT and/or www already
exist in the system.

The assignment of the labels is independent of whether the object is
accessed via Real-Time Ethernet (cyclic and/or acyclic communication) or
not (see also section Examples [ page 27]).

By assigning the labels and in a further step by selecting them (see section
Adding OPC UA, MQTT or WebServer [ page 65]), you can define the
communication path(s) OPC UA, MQTT or WebServer to be used.

» To assign a built-in or a self-created label, click Assign label in the
Object Definitions editor.

» In the Assign label window on the left, select OPC UA, MQTT and/or
www (or a self-created label).

» Click on the arrow @® or double-click on the label, to move the label
into the Assigned labels list.

g Label X
Assign Labels

Select labels for this object from the list of built-in labels or create new.

Label to assign: Assigned labels:

<type label> oPCUA
MQTT

Labels in project:

WWW,
OPCUA
MQTT

® D CZID

Figure 30: Select label for access via OPC UA, MQTT or www (sample selection www)

» In this way, you can select other labels and move to the right, to assign
them to the selected object.

» Click OK.

= The selected labels (for example OPC UA, MQTT and www) are
displayed under Properties > Labels.
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[y Project Explorer % * 0x40010001 - Counter &2

4 LI netX_IOT_project -

4 5 Object Model | | ®=°0x40010001 - Counter @
a F& Object Definitions P
4 B User ~  Properties T
» = Parameter [0x40020001 - 0x40020010]
4 I= Status [0x40010001 - 0x40010010] Identifier 0x40010001
a4 @ 0x40010001 Counter [1.0] Name Counter
#+ Counter1 -
# Counter2 1 Description:
» 5 Standard Version 1.0
> &= Object Instances

» B Communication Settings Type name:  COUNTER

> &= Product Details Labels: OPG UA; MQTT:

> = Vendor Details

> &% User Management L4

> & Web Builder A ¥  Elements Value display mode: m =+

n s Pradost Buoild
W # Elemen.. ¢ Variable . # DataTy. Count ¢ Default Value Aftributes # Description

Counter1 counter1 uint32 1 0 None
type filter text Counter2 counter2 uint32 1 0 None
» & Object Definitions

Figure 31: Object Definition editor - selected labels (sample selection OPC UA, MQTT and
www)

Label Meaning

[custom |Labels to be defined by the user himself. Such labels are used to configure access to objects from the OPC
labels] UA server, via MQTT or from the WebServer.

The self-defined label must be assigned in the object definition and selected in the communication settings
for OPC UA, MQTT or www.

If required, all objects with a self-defined label can also be displayed via the OPC UA server, MQTT and the
WebServer.

OPC UA |From the system predefined label. The label OPC UA serves to configure access from the OPC UA server
to objects.

The label OPC UA must be assigned with the object definition and can be selected in the communication
settings for OPC UA.

Objects with the label OPC UA can also be displayed via MQTT and the WebServer if required.
MQTT From the system predefined label. The label MQTT serves to configure access via MQTT to objects.

The label MQTT must be assigned with the object definition and can be selected in the communication
settings for MQTT.

If required, objects with the label MQTT can also be displayed via the OPC UA server and the Web server.

www From the system predefined label. The label www serves to configure access from the WebServer to
objects.

The label www must be assigned with the object definition and can be selected in the communication
settings for WebServer.

If required, objects with the label www can also be displayed via MQTT and the OPC UA server.
Table 11: Labels for OPC UA, MQTT, www or own labels

The configuration for the access to the object data by the OPC UA
Server, MQTT or the WebServer requires the selection of the labels
assigned during the object definition in the Communication
Settings, in each case in the editor OPC UA > Actions, MQTT >

Connections or WebServer, as well as further settings (see
section Adding OPC UA, MQTT or WebServer [ page 65]).
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Create custom label

» To assign a custom label, click Assign label in the Object Definitions

editor.
» In the Assign label window on the left side in the upper field, enter a
name for your own label (example name "test").
» Click on the arrow @® or double-click on the label, to move the label
into the Assigned labels list.
x - »
Assign Labels
Select labels for this object from the list of built-in labels or create new.
Label to assign: Acsigned labels:
<type label> OPCUA
Labels in project: {\:gﬁ
OPC UA
MQTT
test
® (o]
Figure 32: Creating custom label (example name "test")
» In addition you can select other labels and move to the right, to assign
them to an object.
» Click OK.
= The newly created label (example name "test") is displayed under

Properties > Labels, next to the other labels.

# (0x40010001 - Counter 2

[ Project Explorer &2

4 L netX_|OT_project

4 = Object Model i=f 0x40010001 - Counter @
4 E& Object Definitions P
4 B User ~  Properties 7
- B Parameter [0x40020001 - 0x40020010]
4 = Status [0x40010001 - 0x40010010] Identifier: 0x40010001
4 ® 0x40010001 Counter [1.0] N Count
* Counter1 = ame ounter
# Counter2 Description
» & Standard Version: 1.0
& B Object Instances
» s Communication Settings Type name:  COUNTER
» = Product Details Labels OPC UA; MQTT; test; Assign label
& B Vendor Details
i+ &5 User Management L4
& &3 Web Builder - Elements Value display mode: m -
r o Dradoet Roild
s Object Definitions 5 # Elemen.. # Variable.. # DataTy.. Count # DefaultValue Atributes # Description m
Counter1 counter1 uint32 1 0 None
type filter text Counter2 counter2 uint32 1 0 None
» B Object Definitions

Figure 33: Example assigned labels

Remove label

» You can remove a label by clicking on the label in the list on the right

and clicking on the cross 9.
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5.1.4

~  Elements

Creating elements

Elements for example C100

In example C100, for the counters or parameters (objects 0x40010001 or

0x40020001) the elements are

e counter (number of operating hours) and

e parameters (settings).

How to proceed
» Under Elements click to Add.
2 A new element is added.

Value display mode: m —

# Element _

# Variable _ Count ¢ Default Value Attributes

# Description

# Data Type Add
_ variable_1 uintd 1 0 MNone
Figure 34: Object Definitions editor - create element (example object '0x40010001 Counter’)
For a description on how to use the table Elements, see section Controls
of the Object Definitions editor [ page 49].
Parameter Meaning Range of value/value

Element Name

*

Name of the element that appears also under Object
Instances with the element of the application variant.

Variable Name

Here you can define for each element an additional name
(does not appear under Object Instances).

The variable name is used in the header file objects.h for
defining the object structure in the C programming language.

Recommendation: Use a C-compliant notation, for example
bValue.

Data Type* Data type of the element boolean, uint8, uint16, uint32,
. : : uint64, int8, int16, int32, int64, string,
Example: Selection uint8 real32. realsd
Count Maximum number per data type: For boolean, uint8, uint16, uint32,

A single data type is used for the data types boolean, uint8,
uint16, uint32, uint64, int8, int16, int32, int64, real32, real64,
that is, always count = 1 is valid.

For the data type string: Count =1 ... 1540

uint64, int8, int16, int32, int64,
real32, real64: Count = 1.

For string: Count=1 ... 1540

See also table Object element data
types, size, number,
limits [ page 108].

Default Value*

The default value to be set by the user specifies the initial
value for the data area. The elements of the objects require an
initial value. After a device reset initially the default value is
valid.

If for the example of a temperature sensor that can work in the
operating modes 0 to 3, a default value of 3 is set, this means
that the sensor is operating in the mode 3 when the device
starts.

The default value is dependent on
the application case.
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Parameter

Meaning Range of value/value

Attributes*

The communication attribute for assigning element data to the [None
application or cyclic network communication is set to None by
default. During IOT configuration, the 1/O data is not processed
via netPROXY and the user cannot select anything here.

Description*

Here you can add an additional description for the element. 3 ... 50 characters

*  Elements

Table 12: Parameters of the elements (Object Definitions)

9 Note:

. *Note that the name, data type, default value and the description set
here, are used as defaults when the object is configured in an
application variant. A change of the name, data type, default value
or of the description in the object definition affects all object
instances. In the Object Instances editor in the Element Value
column changes made for the default value will be overwritten by
subsequent changes under Object Definitions > User. Further
details you find in the table Parameters of the elements (Object

Instances) [ page 60].

Element name or variable name

> Double click into the table cell for Element Name or Variable Name to

edit the text.

» Customize the name for the element and the variable.

Data Type

» Double click into the table cell for Data Type or click in the table cell

and press F2.
2 The list of data types will appear.
» Select the data type.

Value display mode: m -

element_1

# Element ..

# VMariable .. ¢ DataType Count ¢ DefaultValue  Aftributes # Description
variable_1 uint32 - 1 0 None

boolean
uint8
uint16
uint64
int8
int16
int32
int64
string
real32
real64

Add

Bemove

Figure 35: Selecting data type

Count

For the data type "string":
» Double click into the table cell for Count.
» Specify the number of data types.
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Default Value

9 Note:

. Note that a change of the default value done with the object
definition affects all object instances. Values that were set with the
configuration of the application variant in the Element value*
column are thereby overwritten.

* See the table Parameters of the elements (Object

Instances) [ page 60].

> To set the default value, double click into the table cell for Default
Value.

> Set the default value.

5.1.4.1 Controls of the Object Definitions editor

In the Object Definitions editor in the table Elements you can perform the
actions described below:

Action Meaning
vale display mode: [l — | Via Value display mode you can choose decimal or hexadecimal
I data view.
~ |Auto Resize Via Auto Resize you can reset the width of the table columns to
the default setting.
[:‘:?) Help Via Help you can open the online help.
Via Add you can add an element.
Via Remove you can remove an element.
(e ] Via Up you can move up an element.
[ Down ] Via Down you can move down an element.

Table 13: Controls of the Object Definition editor
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5.1.4.2

Example for IOT communication via OPC UA or MQTT

In the example of the operating hours counter, the number of operating

hours 'counter1’, 'counter2' and the device settings 'parameter”’,

'parameter2' are used.

In theAttributes column, the list entry None is preset by default for all
elements. Descriptions of data assignment using labels can be found in the
section Performing communication settings [ page 63].

Example objects 'Counter’' and 'Parameter

The following figures show the example objects 0x40010001 Counter and
0x40020001 Parameter and their elements:

4 [ netX_|OT_project =
4 = Object Model
4 £ Object Definitions
4 K& User
4 s Parameter [0x40020001 - 0x40020010]
4 ® (0x40020001 Parameter [1.0]
& Parameter1
& Parameter2
4 & Status [0x40010001 - 0x40010010]
4|® (0x40010001 Counter [1.0]
@ Counter1
@+ Counter2
> & Standard L
» e Object Instances
» Be Communication Settings
> B Product Details

" P= Vandnr Nataile

m

Il Object Definitions &2

type filter text

» & Object Definitions

if 0x40010001 - Counter

~  Properties

Identifier: 0x40010001

Name: Counter

Description

Version: 1.0

Type name: COUNTER

Labels OPC UA; MQTT; test;

~  Elements

Value display mode: M g

I Project Explorer &2 ® (x40010001 - Counter 2

@]

Assign label

# Element.. ¢ Variable .. ¢ DataType Count ¢ Default Value
uint32 1 0
uint32 1 0

counter?
counter?

Counter1
Counter2

Attributes ¢ Description
None
None

4 L% netX_|OT_project =
4 s Object Model
4 5 Object Definitions
4 B User
4 s Parameter [0x40020001 - 0x40020010]
a|® 0x40020001 Parameter [1.0]
@+ Parameter1
& Parameter2
4 B Status [0x40010001 - 0x40010010]
4 ® (0x40010001 Counter [1.0]
*+ Counter1
@+ Counter2
> B Standard L
» = Object Instances
» B Communication Settings
» & Product Details

" B= \ianAdar Nataile

Il Object Definitions &2

type filter text

m

> @ Object Definitions

nf 0x40020001 - Parameter

~  Properties

Identifier 0x40020001
Name: Parameter
Description:

Version 1.0

Type name:  PARAMETER
Labels: OPC UA, MQTT,

~  Elements

Value display mode: m Lad

Figure 36: Example object '0x40010001 Counter [1.0]', elements 'Counter1' and 'Counter2’.

@

Assign label

# Element_. ¢ Variable .. # DataType Count ¢ DefaultValue
Parametert  parameterl  uint32 1 0
Parameter2 parameter2  uint32 1 0

Attributes ¢ Description
None
None

Figure 37: Example object '0x40020001 Parameter [1.0]', elements 'Parameter1' and

'Parameter2’.

The elements for mapping the device properties in the objects are thus

defined.
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5.2 Using standard objects

has at the level of the object definition the possibility to use predefined
default objects. How you can use standard objects is described in the
following sections using the example for Generic Device.

Technical Reference Guide netPROXY, objects and packages,

For more information about predefined standard objects, see the
DOC160204TRXXDE [2].

5.2.1 Adding and displaying Standard objects

» When performing the object definition, right-click on the Standard
folder.

» Click Add.

(1]
iy
4
1
[

[t5 Project Explorer 52

4 [ netX_|OT_project
4 s Object Model
4 [ Object Definitions
> B User
st Standezs
> Bs Object Inde2
» s Communication Settings
> B Product Details
> B Vendor Details
- &8 User Management
> & Web Builder
Figure 38: Using standard objects

 The Standard objects window appears:
» Click on the category for the Standard objects and OK.

Standard Objects
Select standard objects to add to project.

[£] Commeon Communication:
7] EtherMet

Generic Device

7] Internet Protocol v4

[ MaTT

Select all Deselect all
Lo

Figure 39: Selection for Standard objects - example Generic Device

2 In the Project Explorer window the object category Generic Device
appears with the Standard objects contained in this folder.
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» To view an object in the editor on the right side, double click on the
object folder.

2 The appropriate default object is displayed:

4 [ netX_|OT_project
4 & Object Model
4 [ Object Definitions
> fs User
4 &5 Standard
4 &= Generic Device
» ® 0x10001000 Device Description [V0.0.15.0]
0x10001010 Device Type Label [V0.0.15.0]
0x10001020 Device Maintenance [V0.0.15.0]
0x10001030 Device Version Info [V0.0.15.0]
0x10001040 Device Reset Confrol [V0.0.15.0]
» ® 0x10001050 System Status [V0.0.15.0]
> i Object Instances
» &= Communication Settings
» i Product Details
» &= Vendor Details

b
b
b
b

fz User Management
Web Builder

£=f 0x10001000 - Device Description

~  Properties

Identifier: 0x10001000

Name Device Description

Description: | General Vendor information will be stored within the abject. This Object must appear in the npxModule 0

Version V0.0.15.0
Type name: | DEVICE_DESCRIPTION
Labels

~  Elements

[©l

Value display mode: E Lo

Element Na... Variable Na.. Data Type Count Default Value Attributes Description

Vendor Na... abVendorN...  string
Vendor Add... abVendorAd... string
Vendor Ph... abVendorP.. string
Vendor URL abVendorUrl  string

@
2
2
2

64
128
64
64

None
None
None
None

Figure 40: Object editor 0x10001000 - Device Description

Human readable representatio...
Human readable Address
Human readable Telephone
Vendor defined URL, e.g. Ven...
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5.2.2

Copying or removing Standard objects

Copy Standard objects

Standard objects you can copy and paste under Object Definitions >
User.

>
>

>
>

Right-click on a Standard object.
Click Copy.

4 [ netX_|OT_project
4 5 Object Model
4 B Object Definitions
> & User
4 [ Standard

4 | Generic Davica

Y Or\ption [V0.0.15.0]
0x10001010 Device Type Label [V0.0.15.0]
010001020 Device Maintenance [V0.0.15.0]
0x10001030 Device Version Info [V0.0.15.0]
0x10001040 Device Reset Control [V0.0.15.0]

> @ 0x10001050 System Status [V0.0.15.0]

» B Object Instances
> B Communication Settings
> Product Details
> B Vendor Details
> &4 User Management

2 ]
- ]
S ]
o ]

> & Web Builder
Figure 41: Copying Standard objects (example)

[t5 Project Explorer &2

Right-click on the Object Definitions> User folder or subfolder.

Click Paste.

2 The object is inserted.

Remove category with Standard objects

Standard objects can only be removed by removing the entire object
category.

» Right-click on the category folder (in the example Generic Devices).

>

Click on Remove.

[ Project Explorer 22

4 [P netX_|OT_project
« &= Object Model
4 2 Object Definitions
> G User
4 2 Standard
4 B Generic Device
> | ® (x10001000 Device Descriptinn
0x10001010 Device Type Lab
0x10001020 Device Maintenance [V0.0.15.0]
0x10001030 Device Version Info [V0.0.15.0]
0x10001040 Device Reset Control [V0.0.15.0]
> @ 0x10001050 System Status [V0.0.15.0]
» w Object Instances
» B Communication Settings
» &= Product Details
» &= Vendor Details
» &4 User Management
» & Web Builder

s
>
>
>

Figure 42: Removing category with Standard objects (example)

R The selected folder is removed.
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5.2.3  Assigning Standard Objects to OPC UA, MQTT, and WebServer

[ Project Explorer &2

4 [ netX_JOT_project
4 B Object Model
4 [ Object Definitions
> 1 User
4 5 Standard
+ = Generic Device

> &4 User Management
» & Web Builder

An assignment of the standard objects to OPC UA, MQTT or WebServer is

not set up by default and must be configured manually by assigning labels.

communication via OPC UA, MQTT or WebServer and in the

In the section Examples [ page 27] you will find explanations on

section Specifying object properties [ page 43] you will find further
details on label assignment.

Proceed as follows:

>

>

»| ® 0x10001000 Device Description [V0.0.15.0]
> ® 0x10001010 Device Type Label [V0.0.15.0]
» ® 0x10001020 Device Maintenance [V0.0.15.0] Description: | General Vendor information will be stored within the object. This Object must appear in the npxModule 0
> ® 0x10001030 Device Version Info [V0.0.15.0]

Version V0.0.15.0
» ® 0x10001040 Device Reset Control [V0.0.15.0]
» @ 0x10001050 System Status [V0.0.15.0] Type name: | DEVIGE_DESCRIPTION
» = Object Instances Labels OPC UA;
» Be Communication Settings
» B Product Details
> B Vendor Details ~  Elements Value display mode: m -

To assign an existing or self-created label, click Assign label in the
Object definition editor.

In the Assign label window on the left, select OPC UA, MQTT and/or
www (or a self-created label).

Click on the arrow @® or double-click on the label to move the label to
the list of selected labels.

Assign labels x

Assign labels

Select labels for this object from the list of built-in labels or create new.

Label to assign: Assigned labels:
OPCUA OPCUA
Labels in project:

WWW,

0OPC UA

MQTT

® D CZID

Figure 43: Select label for access via OPC UA, MQTT or WebServer (sample selection
OPC UA)

In this way, you can select other labels and move to the right, to assign
it to an object.

Click OK.
The selected labels are displayed under Properties > Labels.

SRR 01000100 evce Descrpion Qo]

%2 0x10001000 - Device Description @)

~  Properties

Identifier 0x10001000

Name: Device Description

Element Na._. Variable Na.. Data Type Count Default Value Attributes Description

Vendor Na... abVendorN... string s 64 None Human readable representatio...
Vendor Ad... abVendorA... string # 128 None Human readable Address
Vendor Ph... abVendorP.. string # 64 None Human readable Telephone
Vendor URL abVendorUrl  string # 64 None Vendor defined URL, e.g. Vend...

Figure 44: Object Definitions editor - selected labels (example selection OPC UA)
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5.3 Configuring application variant (scope of functions)

The products or product variants equipped with IOT functions are compiled
or configured as object instances from the objects created in .

The following main steps are necessary for this:
¢ Define the range of functions of the products or product variants.

¢ On the basis of the defined objects, configure suitable application
variants with the functional scope of the product variants.

e If necessary, adjust the initial value (default value) for all elements used
in the application variants.

The following sections provide a step-by-step description of the procedure.

5.3.1 Define scope of functions

In preparation for programming your application or the device functions or
the 10T functions, you must define the scope of functions which is to be
achieved by supplementing the 10T functions.

In the example C100, the object definition consists of the object for an
operating hours counter 'Counter' and an object for device settings
'‘Parameter’.

Counters or parameters are defined as the functional scope of application
variant C100.

Application Scope of Instance | Object Object name 1 Object name 2
variant functions ID number (for instance) (for object)
Application C100 |2 Counter 0: 0x4001001 Counter Counter

2 Parameter 0: 0x4002001 Parameter Parameter

Table 14: Range of functions, example C100
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5.3.2 Configure application variant

You can create the application variants and their functional scope required
for your products by compiling and configuring the objects defined under
Object Definitions and the device properties mapped in them in
application variants suitable for your products.

To configure an application variant, proceed as follows:

» Create the application variant.

» Configure the objects for the application variant by adding the objects.

» To configure the parameters of the objects, make the following
adjustments:

e Object instances tab:
— Object instance names*
— Default values of the elements**
— Element value**
e Details tab:
- Unit**
— Min Value and Max Value**
*at the object level, **at the element level

You can create additional application variants by cloning the first
application variant or by adding new application variants.

The example used for this manual is shown in the table Range of functions,
example C100 [ page 55].
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5.3.2.1

Create application variant, add objects

To create the first application variants and configure the objects for them,

proceed as follows:

Create application variant

> In the Project Explorer window, right-click the Object Model > Object

A\

Instances folder.

ol
it
4
1
[

[ty Project Explorer &2

4 [ netX_|OT_project
4 & Object Model
4 £ Object Definitions
4 B User
4 5 Parameter [0x40020001 - 0x40020010]
@ (0x40020001 Parameter [1.0]
4 B Status [0x40010001 - Ox40010010]
» @ 0x40010001 Counter [1.0]
I B Standard

|Bs Object Instances —_
e
& & Product Details
i+ B Vendor Details
r &4 User Management

b #% Web Builder

Figure 45: Create application variant

Click New Application.
The New Application window appears.
New Application £

New Application

Enter the name of the new application.

il

Application name:

Cancel

Figure 46: Enter name for first application variant

Under Application name type the new name for the first application
variant.

= Rename Application &
Rename Application

Enter the new name of the Application.

Application name: * Application C100

c
Figure 47: Example Application C100

Click OK.
The folder for the application variant appears.
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Configure objects of the application variant

variant.

[t Project Explorer &2 BES ~ - =&

4 [ netX_IOT_project
4 5 Object Model
4 s Object Definitions
4 Bk User
4 B Parameter [0x40020001 - 0x40020010]
| @ 0x40020001 Parameter [1.0]
4 Bs Status [0x40010001 - 0x40010010]
> | ® 0x40010001 Counter [1.0]
> B Standard
4 & Object Instances
= Application C100
> B Communication Settings
> = Product Details
> B Vendor Details
> &% User Management
> #% Web Builder

To configure the application variant, you must drag the object folders
created for your product to the application variant folder. In the example,
the folders 0x40010001 Counter [1.0] or 0x40020001 Parameter [1.0] are
dragged into the folder Application C100.

» Click on the folders for the objects to be used in the first application

Figure 48: Application Variant (Example Application C100) - Compile Objects Using

Drag and Drop

variant.

1]
iy
L]
1
[

[t5 Project Explorer &2

a [ netX_|OT_project
4 I Object Model
4 E Object Definitions
4 B User
4 5 Parameter [0x40020001 - 0x40020010]
> | @ 0x40020001 Parameter [1.0]
4 5 Status [0x40010001 - 0x40010010]
> @& 0x40010001 Counter [1.0]
» B Standard
4 5 Object Instances
4 & Application C100
#® (0: 0x40010001 - Instance - 0 - Counter
® (0: 0x40020001 - Instance - 0 - Parameter
> B Communication Settings
> B Product Details
> = Vendor Details
> & User Management
> &3 Web Builder
Figure 49: Application variant (example Application C100)

procedure.

» Drag and drop the selected objects into the folder of the application

» If an object is used more than once in the application variant, repeat the
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5.3.2.2 Customizing object parameters (Object Instances)
To configure the objects, in the Object Instances tab perform the following
adaptions:
e Object instance names*
e Default values of the elements™*
e Element value**

*at the object level, **at the element level

Customize object instance names and default values of the elements

You can customize the names of the object instances of the application
variant, to get a name structuring, that is suitable for your product variants.
Furthermore, for each object, configured in the application variant, or for the
elements within it, you can individually adapt the default values, where
appropriate.

» To rename the object instances, you first double-click on an object
folder of the application variant.

2> In the editor, the application variant is displayed (in the example
Application C100).

[ Project Explorer &2 1 Application G100 &2

4 [ netX_IOT_project

4 s Object Model E‘Application Cc100 Value display mode: = @
4 B Object Definitions type filter text
a 5z User E
4 &= Parameter [0x40020001 - 0x40020010] Object Element .. Element . Element . Aftribut . Description m
> ® 0x40020001 Parameter [1.0] > 0x40010001 - Counter
4 & Status [0x40010001 - 0x40010010] ] 0x40020001 - Parameter

> ® 0x40010001 Counter [1.0]
> & Standard
4 & Object Instances
4 = Application C100
# 0: 0x40010001 - Instance - 0 - Counter
# 0:0x40020001 - Instance - 0 - Parameter
> B Communication Settings

Figure 50: Editor of the application variant (example)

» Click in the editor on the line with the object description (in this example
0x40010001 counteror 0x40020001 parameter) and expand the lines
below, which display the instances and the element data.

[t Project Explorer 52 B Application C100 2
4 [ netX_|OT_project . . .
4 Bs Object Model =3 Appllca‘tlon c100 Value display mode: m A SR )]
4 O.bject Definitions type fiter text
4 Fa User
4 B Parameter [0x40020001 - 0x40020010] Object Element ... Element... Element.. Attribut.. Description
> @ 0x40020001 Parameter [1.0] 4 0x40010001 - Counter -
4 B Status [0x40010001 - 0x40010010] 4 #Instance - 0
> @& 0x40010001 Counter [1.0] Counter1  uint32 “0 None
> far Standard Counter2  uint32 “0 None
4 & Object Instances 4 0x40020001 - Parameter
4 = Application G100 4 “Instance - 0
@ (: 0x40010001 - Instance - 0 - Counter Paramete... uint32 “0 MNone
@ 0: 0x40020001 - Instance - 0 - Parameter Paramete.. uint32 “0 Mone
» Bs Communication Settings

Figure 51: Editor application variant with lines for the instances and elements (example)

For a description of how to use the table, see section Controls of the
Application Variant editor.
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Parameters of the elements (Object Instances)

Parameters

Meaning

Range of value/value

Object

Object description:

In the Object column the object descriptions appear, that result from
the composed names of the object identifier (Object Identifier) and
the object name (Object name); (not editable).

The object identifier (Object Identifier) is set in the New Object
window (see table New object — parameters [ page 39]). The object
name (Object name) is set in the Object Definitions editor. See table
Properties — Parameters (Object Definitions).

Instance names:

Below each object description, the names of the associated object
instances appear (editable).

Element Name

Name of the element that was created under Object Definitions
(not editable) See table . See table Parameters of the elements
(Object Definitions) [ page 47].

Element Type

Data type of the element that was configured under Object
Definitions (not editable here). See table Parameters of the
elements (Object Definitions) [ page 47].

Bit, uint8, uint16, uint32, uint6é4,
int8, int16, int32, int64, string,
real32, real64

Element Value

Here editable default value, which applies to the element as the
initial value

As long as Element Value was not customized, the under Object
Definitions in the Default Value field globally configured value
appears. See table Parameters of the elements (Object
Definitions) [ page 47].

For each object, configured in the application variant, or for the
elements within it, the value for Element Value can be adapted
individually. This means, in the example C100, the default values for
each counter or parameter can be set separately.

Note: A change of the global default value under Object
Definitions overwrites all individually set default values.

The default value depends on
the application and is defined
by the user.

Attributes

Not used (not editable here)

None

Description

Under Object Definitions typed description for the element (not
editable). See table Parameters of the elements (Object
Definitions) [ page 47].

3 ... 50 characters

Table 15: Parameters of the elements (Object Instances)
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» To change the name for the object instance, move the cursor with a
double-click in the cell in the Object column that contains the instance
name (in the example Instance 0).

[ Project Explorer & B Application C100 &2
4 [ netX_IOT_project . ; .
4 s Object Model [ Appllcatlon C100 Value display mode: m =T @
4 & Object Definitions type fiter text
4 B User
4 s Parameter [0x40020001 - 0x40020010] Object Elerment ... Element.. Element ... Attribut.. Description
» ® 0x40020001 Parameter [1.0] 4 0x40010001 - Counter
4 B Status [0x40010001 - 0x40010010] 4 ?Instance - 0
» ® 0x40010001 Counter [1.0] Counter!  uint32 ‘0 None
» % Standard Counter2  uint32 ‘0 None
4 = Object Instances 4 0x40020001 - Parameter
4 | Application C100 4 7 Instance -1
@ 0: 0x40010001 - Instance - 0 - Counter Paramete . uint32 ‘0 None
@ 0: 0x40020001 - Instance - 1 - Parameter Paramete . uint32 ‘0 None

> B Communication Settings
» % Product Details

> B Vendor Details

> #4 User Management

> &% Web Builder
Figure 52: Editor application variant - editing instance name (example)
» Enter an instance name suitable for your application variant (in the
example Status or Parameter).
[ Project Explorer & % Application G100 &2
4 [ netX_IOT_project . . a
4 B Object Model I Appllcatlon Cc100 Value display mode- Ex = @
» & Object Definitions type fiter text
4 Im Object Instances .
4 B Application C100 Object Element Name Element Ty... Unit Min Value Max Value
® 0: 0x40010001 - Status - Counter IS 0x40010001 - Counter
# 0 0x40020001 - Parameter - Parameter Counter1 uint32 # # #
> Bs Communication Settings Counter2 uint32 & & &
> = Product Details 4 0x40020001 - Parameter
> = Vendor Details Parameter1 uint32 # # #
> & User Management Parameter2 uint32 & & &
> &2 Web Builder

Figure 53: Editor of the application variant with product-related instance names (example)

Customize element value (Element value)

0 Important:
In the editor for an application variant, you can edit Element value.

Note that a change of the global default value in the Default Value
field, under Object Definitions, overwrites all in the Element Value
field, under Object Instances, individually set default values.
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5.3.2.3

[t Project Explorer &2

Customizing object parameters (Details)

To configure the objects, in the Details tab perform the following adaptions:

e Unit*™
e Min Value and Max Value**

**on element level

Change Unit, Min. Value and Max. Value per element

For the objects configured in the application variant, you can individually
customize for each contained element the parameters Unit and Min Value

(minimum value) or Max Value (maximum).

» In order to make the changes for Unit, Min Value and Max Value per

element, click the Details tab.

% Application C100 &2

4 [ netX_|OT_project . B .
4 & Object Model = Appllcatlon Cc100 Value display mode: D= ®
» B Object Definitions type filter text
4 B Object Instances B
4 s Application G100 Object Element Name Element Ty . Unit Min Value Max Value
© 0: 0x40010001 - Status - Counter IS 0x40010001 - Counter
# 0: 0x40020001 - Parameter - Parameter Counter1 uint32
> B Communication Seftings Counter2 uint32
> B Product Details 4 0x40020001 - Parameter
> &= Vendor Details Parameter1 uint32
> &2 User Management Parameter2 uint32
> &2 Web Builder
Figure 54: Editor of the application variant - changing Unit, Min./Max. Value (example)
Parameter Meaning Range of value/value
Object In the Object column the object descriptions appear that result from

the composed names of the object identifier (Object Identifier) and
the object name (Object name); (not editable).

The object identifier and object name are set in the New Object
window (see table New object — parameters [ page 39]). The object
name can be adjusted in the Object Definition Editor. See table
Properties — Parameters (Object Definitions).

Element name

Name of the element that was created under Object Definitions
(not editable) See table Parameters of the elements (Object
Definitions) [ page 47].

Element Type Data type of the element, which was configured under Object Bit, uint8, uint16, uint32, uint64,
Definitions (not editable) See table Parameters of the elements int8, int16, int32, int64, string,
(Object Definitions) [ page 47]. real32, real64
Unit** Extensive list of units (e. g. m, kg, Pa, Hz, bit, byte
etc.)
Min Value Freely editable minimum value for the element value
Max Value Freely editable maximum value for the element value

Table 16: Parameters of the elements - Details (Details)

» Double-click each in the cell to be adapted and select for Unit a
physical unit, select for Min Value a lower limit or Max Value an upper

limit for the appropriate value.
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5.4 Performing communication settings

To configure the communication settings in :

¢ Add the communication settings for each application variant and select
the IOT protocol and the application (loT protocol, Application).

e Configure access to object data via OPC UA or MQTT (only permitted
combinations), or WebServer if necessary.

e For OPC UA or MQTT, make the settings for IOT communication
individually.

The following sections provide a step-by-step description of the procedure.

5.4.1 Adding communication settings

You can add communication settings for one loT protocol (OPC UA or
MQTT) for each application variant.

9 Note:
. Each application variant can be combined with one |oT protocol.

Note that in the basic version of "netX Studio (netPROXY Basic)",
you can configure only one communication protocol (network).

Add communication settings

» To add communication settings for an application variant, right-click the
Communication Settings folder in the Project Explorer window.

[t Project Explorer 2

4 [ netX_|OT_project
> B Object Model
- | Communication Sattiaa —_—
. = Product Details | i, New Communication Setting
> &= Vendor Details
- &2 User Management
» &5 Web Builder

Figure 55: Project Explorer - New Communication Setting

» Click New Communication Setting.
2 The dialog box Add Communication Settings appears.
» Under loT protocol, select the protocol.

Add Communication Settings X

Add Communication Settings

Provide informaticn for the communication settings.

IoT protocol: (Loadable firmware with OPC UA -]
Aoolication: Loadable firmware with MQTT
Al | 0adable firmware with OPC UA I
® ca

Figure 56: Add Communication Settings - loT protocol

» Under Application select the application variant.
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Add Communication Settings *

Add Communication Settings

Provide information for the communication settings.

IoT protocok: [Loadabl.e firmware with MQTT ']

-

Application: |Application C100

Application C100 ]

Figure 57: Add Communication Settings - Application (example)

» Supplement the communication settings for further application variants.

If you have added the communication settings for each application variant
(one combination with OPC UA or MQTT), the message appears that no
more applications are available for the 10T configuration.

Add Communication Settings

€3 Mo more applications for [oT cenfiguration,

IoT protocol: |Loadable firmware with MQTT vl

Application: |No more applications for IoT configuration.

®

Figure 58: Add Communication Settings — No more applications

Removing communication settings

» To remove the communication settings for an application varinate, right-
click the corresponding folder in the Project Explorer window below the
Communication Settings folder.

{5 Project Explorer &2 BES ~ - =

4 [ netX_|OT project
i B Object Model
4 B Communication Settings

= = - mn
RESHES cerove_Dsee_]
i& Product Details

- s Vendor Details
&% User Management
£ Web Builder

Figure 59: Project Explorer - Remove (example)

» Click on Remove.
= The selected communication settings will be removed.
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54.2 Adding OPC UA, MQTT or WebServer

Object data can be transferred via OPC UA or MQTT or WebServer (see
also section Examples [ page 27]).

For the configuration of OPC UA or MQTT (or WebServer if necessary) it is
necessary that you

e Assign one or more predefined labels (OPC UA or MQTT or
WebServer) or self-created labels to each object in the Object
Definitions Editor via Assign label (see section Specifying object
properties [ page 43]).

¢ under Communication Settings, add the editor OPC UA or MQTT or
WebServer to each application variant, select the assigned labels again
in the editor and perform the configuration as described below.

0 Important:
OPC UA and MQTT must not be used simultaneously in the
communication settings for one and the same application variant.

Note about the requirements of your end customer

0 Important:

The is a device development tool. It does not contain any
configuration and diagnostic functions for the end user and is not
available for the end customer. Because of this reason, note that
you must provide to your customer a tool or a solution for the final
configuration of the device!

For the final configuration your customer requires a suitable tool with
configuration and diagnostic functions. The final configuration includes the
indication of the MQTT broker, the indication of the OPC UA port, the user
management, as well as simulation steps in preparation for the device
commissioning.

To offer to your customer an appropriate solution, you have two options:

¢ When developing the device with , add the option for communicating via
the WebServer.

e Or provide for the end customer an alternative solution to make the final
configuration.

— For example, you can offer to the customer a service for the
complete device setup,

— you can offer to your customers a generic solution,
— agree with the customer that he must develop his own solution or
— you schedule a service by the device manufacturer.
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Add editor for OPC UA, MQTT or WebServer

» Under Communication Settings, right-click the folder containing the
communication settings of an application variant.

0 Important:
OPC UA and MQTT must not be used simultaneously in the
communication settings for one and the same application variant.

> ClickAdd OPC UA, Add MQTT or Add WebServer.

2 The configuration takes place so that the functions for transferring the
object data to the OPC UA server, MQTT or WebServer can be used.
The folders OPC UA, MQTT or WebServer are displayed in the Project

Explorer.

4 [ netX_IOT_project
> B Object Model
4 & Communication Settings
4 ? gpi():ljllc:“???_]l[H ¥ Remove
i — Add Web Server
B Actions

4 Add MQTT
& Product Details 5

[ Project Explorer

Delete ‘

> Bs Vendor Details
> &% User Management
> & Web Builder

Figure 60: Communication Settings of an Application Variant, Example Add WebServer
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5.4.2.1

[~ Project Explorer &2

4 [ netX_OT_project
> &= Object Model

4 &= Communication Settings

4 & Application C100
B Web Server
4 B OPC UA
B Actions
% Product Details
> = Vendor Details
- &4 User Management
» &2 Web Builder

Communication settings for OPC UA

To configure the communication settings for OPC UA, proceed as follows:

> Double-click on the OPC UA folder.

2 The OPC UA editor appears.

Under OPC UA Server Configuration you can configure various settings.

B OPC UA Server Configuration

Server Configuration

Use "Vendor Information”
Vendor name: Vendor Name
Component name: OPC UA Server
Software version

Build timestamp

General

Server port: 4840
Maximum allowed nodes: 2000
Maximum sessions: 2
Maximum session lifetime 1200000
Maximum subscriptions per session 2
Monitored ltem

Minimum sampling rate: 1000

Maximum gueue size for monitored items: | 1

Maximum items per subscription 10
Subscription

Minimum keep alive interval Count: 2
Maximum keep alive interval Count 100

Minimum lifetime counts per subscription: 6

Maximum lifetime counts per subscription: = 300

*

S

[Tl Use Hilscher default

Options
Enable
Allow anonymous
Allow User/Password access
[7] Support authorization
ms

UA Services

ms Write service
Manitored Item Service Set
Subscription Service Set

Default

@

Figure 61: Communication Settings > OPC UA Editor - OPC UA Server Configuration

(example)

Parameters OPC UA Server Configuration

Use ,Hilscher
default”

Hilscher standard values for Software version and
Build timestamp.

Parameter Meaning Range of value/value
Use ,Vendor The default values of the OPC UA server are used |Unchecked, unchecked,
information” for Vendor name and Component name, or Default: Use "Vendor information"

checked

Vendor name

Here you can enter the vendor name freely. This
one may be identical or different, as typed under
Project Explorer > Vendor Details > Vendor
Information (see section Entering vendor
information [ page 82]).

String (max. 63 characters.),
Default: Hilscher Ges. fiir
Systemautomation mbH

Component name

String (max. 31 characters.),
Default: OPC UA Server

Software version

String for storing the software version:
'MAJOR.MINOR.REVISION.BUILD TEXT'

netX Studio Engineering Tooll | IOT Configuration
DOC1804040I01EN | Revision 1 | English | 2018-11 | Released | Public

© Hilscher 2018 — 2018



IOT configuration

68/115

Parameter

Meaning

Range of value/value

Build timestamp

String to store the build timestamp
Format: 'yyyy-MM-dd'T'HH: mm: ss.SSSXXX"

yyyy: year, MM: month, dd: day,

T: fixed character (for time), HH: hours,

mm: minutes ss: seconds SSS: milliseconds,
XXX: time zone; additionally: Z for UTC +00: 00

Example: 2016-04-07T12:34:11.123Z

General
Server port IP port number of the OPC UA server Valid port,
Port 0 and 1 are not supported. 0,2, 3, ...65535;
Default: 4840
Maximum allowed Allowed maximum number of nodes which the 400 ... 2000,

nodes

server can represent in the defined address space.
These are self defined nodes that are configured
by the as well as the the mandatory server nodes.

Default: 2000

Maximum sessions

Allowed maximum number of UA session which the
server has to handle. The nano profile requires
only 1.

UA communication is divided into sessions.

1, 2,
Default: 2

Maximum session
lifetime

Allowed maximum lifetime for a UA session in ms.

30000 ms ... 1200000 ms
(30 s to 20 min),
Default: 1200000 ms (20 min.)

Maximum
subscriptions per
session®

Allowed maximum number of subscriptions per
session

Min: 1, Max: 2,
Default: 2

Options

Options for configuring the OPC UA server communication.

Enable

Enable

Checked, unchecked,
Default: checked

Allow anonymous

Allow anonymous access

Checked, unchecked,
Default: checked

Allow User/Password
access

Allow User/Password access

Checked, unchecked,
Default: checked

Support authorization

Support authorization

Checked, unchecked,
Default: unchecked

Monitored Item

Minimum Sampling
rate in ms*

The sample rate defined for a monitored item may
be faster than the publishing rate of the
subscription. For this reason, the monitored item
may be configured to either queue all notifications
or to queue only the latest notification for transfer
by the subscription. In this latter case, the queue
size is one.

Min: 50,
Default: 1000

Maximum queue size | Supported maximum queue size for monitored Max: 1,

for monitored items* |items Default: 1
Maximum items per |Supported maximum items per subscription Max: 10,
subscription* Default: 10

UA services

Write service

Enable write access to OPC UA objects (default)

Checked, unchecked,
Default: checked

Monitored Item
Service Set

Enable Monitored Item Service Set (default)

Checked, unchecked,
Default: checked

Subscription Service
Set

Enable Subscription Service Set (default)

Checked, unchecked,
Default: checked

Subscription
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Parameter Meaning Range of value/value
Minimum keep alive | Supported minimum number of 'Keep Alive Interval |Min: 1, Max: Subscription: Maximum
interval Count* Counts'. 'Keep Alive Interval Count'

Default: 2

Maximum keep alive
interval Count*

Supported maximum number of 'Keep Alive Interval
Counts'

Min: Subscription: Minimum 'Keep
Alive Interval Count',

Max: 1431655765 (1/3 *
UINT32_MAX)

Default: 100

Minimum lifetime
counts for
Subscriptions*

Supported minimum Lifetime counts for
Subscriptions

Max: 4294967295 (UINT32_MAX),
Default: = Min: 3 x Subscription:
Minimum 'Keep Alive Interval Count'

Maximum lifetime
counts for
Subscriptions*

Supported maximum Lifetime counts for
Subscriptions

Min: Subscription: Minimum Lifetime
Counts for Subscriptions,

Max: 4294967295 (UINT32_MAX);
Default: 3 x Subscription: Maximum
'Keep Alive Interval Count'

*only available in Micro Server

Table 17: Parameters OPC UA Server Configuration

Parameters OPC UA Actions Configuration
» Double-click on the OPC UA > Actions folder.

2 The OPC UA Actions editor appears. Under Filter the selection for the
label OPC UA is pre-configured by default. In the table below, you can
configure the type of access read or write for each object instance

configured for OPC UA.

BEg ~
4 B9 netx_IOT _project E OPC UA Actions Configuration
> B Object Model
4 & Communication Settings
4 E& Application G100
E Web Server
4 E OPCUA
B Actions
& Product Details
» = Vendor Details

Actions Configuration

Filter OPC UA

Object #  Action
500 0x40010001 - Counter

Status read

@

Select label

> &y User Management s 0x40020001 - Parameter
» & Web Builder Parameter read
Figure 62: Communication Settings > OPC UA Editor - OPC UA Actions Configuration
(Example)
Parameter | Meaning Range of value/
value
Object Object name, which was specified in the New Object window, and which was [Name of the object
adapted if necessary, in the Object Definitions editor (see table Properties —
Parameters (Object Definitions), cannot be edited here).
Action Read and write services; sub-function of the overall OPC-UA functionality; see | read, write,

also tableObject functions [ page 11] .

Default: read

Table 18: Parameter OPC UA Actions Configuration

Note:

For objects with access via WebServer, you can additionally

configure access via the OPC UA Server and display the object
data configured for the WebServer on the OPC UA Server.
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5422 Communication settings for MQTT

To configure the communication settings for MQTT, proceed as follows:
» Double-click on the MQTT folder
2 The editor MQTT Component Information appears.

5 Project Exlorer I = HaTT tovicaion 0100 - T
B% -
4 @ netx_JOT_project E MQTT Component Information @
> B Object Model
4 s Communication Settings ~*  Component Information
4 &= Application C100
B Web Server ste "Wendor Information” || Use Hilscher default
« B MQTT _ Viendor name Vendor Name
B Connection
% Product Details CGomponent name Eclipse Paho MQTT Client

» &= Vendor Details Software version

’ ;"‘ User Management Build timestamp

> &2 Web Builder

Figure 63: Communication Settings > MQTT Editor - MQTT Component Information
(Example)

Parameter Meaning Range of value/value
Use ,Vendor The default values of the Eclipse Paho MQTT Checked, unchecked,
information® Client are used for Vendor name and Component | Default: Use "Vendor information"
Use ,Hilscher na:ng,:r :gsgh%dt_erf;‘aulttviues for Software checked
default* version a uild timestamp.
Vendor name Vendor name. String (max. 63 characters.),

Default: Hilscher Ges. fiir

Here you can enter the vendor name freely. This Systemautomation mbH

one may be identical or different, as typed under
Project Explorer > Vendor Details > Vendor
Information (see section Entering vendor
information [ page 82]).

Component name Component name String (max. 31 characters.),
Default: Eclipse Paho MQTT Client
Software version String to store the software version: -
'MAJOR.MINOR.REVISION.BUILD TEXT'
Build timestamp String to store the build timestamp -
Format:

YYYy-MM-dd’ T’"HH:mm:ss.SSSXXX’

yyyy: year, MM: month, dd: day, T: fixed character
(for time), HH: hours, mm: minutes ss: seconds
SSS: milliseconds,

XXX: time zone; additionally: Z for UTC +00: 00

Example: 2016-04-07T12:34:11.123Z
Table 19: Parameters MQTT Component Information
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Parameter MQTT - Connection

» Double-click on the MQTT > Connections folder.

2 The MQTT editor appears.

MQTT Connection
Parameter Meaning Range of value/value
Client ID Unique name of the MQTT client in UTF-8 format. |max. 23 Bytes for max. 23

All devices that are connected to a broker, must
have a unique name. If the field is empty, then the
broker assigns a name.

chaacters,
Default: [Client ID]

Broker address

IP address of the broker

Valid IP address;
Default: [BrokerAddress]

Topic prefix Text that is prefixed to each topic, Text of uppercase and lowercase
e. g. 'StationA'. For each single topic can be letters and underscore,
configured if this prefix is to be preceded or not. Default: [not specified)]
User name User name to login to the broker. [not specified] or user name,
Default: [not specified]

Password Login password to the broker. [not specified] or password,
Default: [not specified]

Will topic Will Topic Text of uppercase and lowercase

letters and underscore;
Default: [not specified]

Connect timeout

Time for trying to establish a connection (MQTT
Connect) to the broker. If the connection could not
be established, then the MQTT client waits for the
duration of 'Connection Timeout' until a new
connection is established to the broker.

Specified in s. =
0 MQTT client constantly tries to

establish a connection to the broker.

Default: 0

Connection idle
timeout

Time after an unused connection (no data
transmission) is closed.

Specified in's. 0 = no timeout, i. e.
connection remains open.
Default: 0

MQTT keep alive
interval

Interval in which the MQTT client sends a sign of
life to the broker. The set value for the MQTT client
must be less than the monitoring time set in the
broker.

Specified in s.

0 = send no sign of life to the broker.

Default: 0
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Parameter

Meaning

Range of value/value

Handling of an MQTT
connection

Clear session:
Setting whether all topics are to be transferred to
the broker after establishing a connection or not.

unchecked (recommended): After a connection to
the broker has been established, all topics of the
type 'publish’ are transmitted from the MQTT client
to the broker .

Unchecked: Only those topic are transmitted to the
broker, which have changed since the last
connection. Note that if you use this setting, the
broker must support the 'preserve context' function.

Checked, unchecked,
Default: checked

Reliable:
Parallel or sequential transmission.

unchecked: parallel transmission of MQTT
services.

checked: sequential transmission of MQTT
services.

Checked, unchecked,
Default: unchecked

Will:
unchecked: Will function disabled.
checked: Will function enabled.

Checked, unchecked,
Default: unchecked

Prefix will:
unchecked: Will-Topic unprefixed.
checked: Will-Topic with prefix.

Checked, unchecked,
Default: checked

Secure:
unchecked: unsecured data transmission.
checked: secured with SSL data transfer.

Checked, unchecked,
Default: unchecked

Verify certificate:
Without function.

Checked, unchecked,
Default: unchecked

Table 20: Parameters MQTT - Connection Settings

netX Studio Engineering Tooll | IOT Configuration
DOC1804040I01EN | Revision 1 | English | 2018-11 | Released | Public

© Hilscher 2018 — 2018



IOT configuration

73/115

MQTT Configuration

Under MQTT Configuration > Filter the selection for the label MQTT is
preconfigured by default. In the table below, the parameters Action,
Retained, Prefix, Encoding QoS or Topic transferred to MQTT for the
objects of the corresponding application variant appear.

Parameter Meaning Range of value/value
Object - Object name - cannot be edited - which was specified in | Name of the object
the New Object window, and which was adapted if
necessary in the Object Definitions editor (see table
Properties — Parameters (Object Definitions)).
Below - the name of the object instance -, as set in the
Application Variant editor and below
- name of the element -, which was set under Object
Definitions (see table Parameters of the elements (Object
Definitions) [ page 47]).
Action Publish: MQTT client should transmit this topic to the Publish, Subscribe,
broker. Default: Subscribe
Subscribe: MQTT client should receive this topic from the
broker.
Retained Setting whether the broker shall store the history of a data | Checked, unchecked,
value or not. Default: checked
Unchecked: Broker shall not store history.
Checked: Broker shall store history.
Prefix Unchecked: The topic prefix shall not be proceeded to this [ Checked, unchecked,
topic. Default: unchecked
Checked: The topic prefix shall be proceeded to this topic.
Encoding Data format of the topic. No encoding, UTF-8/MBCS, JSON;
No encoding: Topics are transmitted in binary form. Default: JSON
JSON: data is transmitted in JSON format,
i. e. together with information on data type, data size and
data value.
UTF-8/MBCS: data is transmitted as text in UTF-8/MBCS
format.
QoS Quality of Service. At most once, At least once,
Setting: :Default: At most once
0 = At most once: data reception is not confirmed via
MQTT.
1 = At least once: data reception is confirmed via MQTT.
2 = Exactly once: data is transmitted via MQTT exactly
once by state machine and confirmed.
Topic Unique name for the topic, editable. Max. 128 characters of text from

uppercase and lowercase letters
and underscore.

Table 21: Parameters MQTT Configuration

9 Note:
. For objects with access via WebServer, you can also configure
access via MQTT and display the object data configured for the

WebServer via MQTT.
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54.2.3 Communication settings for WebServer

(5 Project Explorer &3

4 [ netX_|OT_project
» = Object Model
4 s Communication Settings
4 B Application C100
E Web Server
> B OPC UA
B Product Details
> fm Vendor Details
» &5 User Management
> £ Web Builder

To configure the communication settings for WebServer, proceed as
follows:

> Double-click on the WebServer folder.

2 The WebServer editor appears. Under Filter the selection for the label
www is pre-configured by default. In the table below, the object data
transferred to the WebServer appears.

HWEb Server Value display mode: m = @
Filter: www.
Object Element N... Element Ty... ElementV... Attributes Description
I 0x40010001 - Counter
4 Status
Counter1 uint32 0 None
Counter2 uint32 0 None
- 0x40020001 - Parameter
4 Parameter
Parameter!  uint32 0 MNone
Parameter2  uint32 0 MNone

Figure 64: Communication Settings > example WebServer editor (default selection www)

For a description for the table in the WebServer editor, refer to the table
Parameters of the elements (Object Instances) [ page 60]. But the values
for Element Value cannot be edited here.

Information on Value display mode and the icons Toggle Expand or
Collapse All etc., see section Controls of the Application Variant editor

) Note:

. For objects with access via OPC UA or MQTT, you can also
configure an access via the WebServer and display the object data
configured for the OPC UA server or MQTT in addition at the
WebServer. For this, the label "www" must be selected in the object
configuration!
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5.5 Configuring product details

allows to enter data for product identification under Product Details. The
following main steps are necessary for this:

1. Preparation
» Write down the product details for your devices.

These product details include:

e Product information
(product name, product ID, product type, order ID, profile ID, profile
type) and

e Product version information
(product revision, hardware name, hardware version, software name,
software version, bootloader name, bootloader version).

2. Configuration in netX Studio Engineering Tool
» Create for each device a folder for the product details.
» Configure the product details data.
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5.5.1 Creating folders for product details

» To create a folder for product details, right-click on the folder Product

Details.
» Click New Product.

[+ Project Explorer &2

4 % netX_IOT project
i B Object Model
- & Communication Settings

Bs Product Detailz

I & Vendor Details
I 4 User Management
i &2 Web Builder

Figure 65: Product Details — New Product

i, New Product

2 The dialog box Add New Product appears.

Add New Product X

Add New Product

Provide information for the product.

Product name: *

Communication setting: | Application C100 -

Application C100 ]

®

Figure 66: Enter the name and select the communication settings

» In the Product name * field type a short term for the product.

2 The used product name appears under Product Details in the folder

name for the product.

9 Note:
. Always use the same product name for a product, so you can

always recognize the data of this product!

Use the same product name also in the Product Information editor
under Product Type in the field Product name *.

Add New Product X

Add New Product

Provide information for the product.

Product name: * Counter

Communication setting: | Application C100 -

Application C100 ]

® D CID

Figure 67: Enter the name and select the communication settings

» Under Select Communication Settings select the communication

settings for the product.
» Click OK.

2 The new product folder appears with the subfolders Product

Information and Product Macros.
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(5 Project Explorer &2

4 L% netX_IOT _project

> I Object Model

» B Communication Settings

4 &% Product Details

a & C100 (Application C100)

0 Product Information
B Product Macros

: I Vendor Details

» &p User Management

> &8 Web Builder

Figure 68: Product Details — example

note Web Builder [5].

‘ For detail about the Product Macros folder, refer to the application

» This way, create all your products.

You can rename the folder for product details or remove (see also
Renaming or removing product details [ page 78]).
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5.5.1.1 Renaming or removing product details
Product details, you can rename or remove.
Rename product details

» Right-click on the folder Product Details> [product name].
» To rename your product, click Rename.

[ Project Explorer 2

4 [ netX_|OT_project
> B Object Model
> @@ Communication Settings
4 & Product Details
+ Guli ophcan
© Product Informsz
. ¢ Remove Delete
B Product Macros
> = Vendor Details
> &4 User Management
> 25 Web Builder
Figure 69: Product Details — renaming (example)

» Type the new product name in the dialog box Rename Productin the
Product name * field.

2 The changed product name appears under Product Details in the folder
name for the product.

9 Note:
. Always use the same product name for a product, so you can
always recognize the data of this product!

Use the same product name also in the Product Information editor
under Product Type in the field Product name *.

Rename Product

Enter new product name.

Product name: *

Figure 70: Rename Product

» Click OK.
= The product folder appears with a new name.
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Remove product details
» Right-click on the folder Product Details > [product name]
» To remove your product, click Remove.

[ Project Explorer &2 BES - - =

4 [ netX_IOT_project
> & Object Model
> B Communication Settings
4 B Product Details

4 &= C100 (Application };’Rename 2 II

© Product Informa

E Product Macros
> i Vendor Details
> &5 User Management
» & Web Builder

Figure 71: Product Details — removing (example)

= The product is removed.
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5.5.2 Entering product information

) Note:
. Entries in the Product Information editor affect in various standard
objects.

>
= The Product Information editor (on the right side) appears.

[ Project Explorer & © Product Information [G100 (Application G100)] %—

4 G netx_IOT _project © Product Information @
» &= Object Model
> = Communication Settings Product Type
4 fw Product Details

4 B= C100 (Application C100) Product name: | Product Name
@ Product Information Product ID- 1
B Product Macros
» &= Vendor Details Productitype:  [Product Type]
> =4 User Management Order ID [Order ID]
» &2 Web Builder Profile ID 0

Profile type: [Profile Type]

Product Version

Product revision V1.0.0.0
Hardware name: [Hardware Name]
Hardware version:  y1.0.0.0
Software name: [Software Name]
Software version V1.00.0

Bootloader name:  [Bootloader Name]

Bootloader version:  y1.0.0.0

4 . *

P 8
Figure 72:

» Select in the Product Information editor under Product Type the product
type, or add under Product Version the product version details.

9 Note:
. Always use the same product name for a product, so you can
always recognize the data of this product!

The product name typed under Product Type in the Product Name
field is used in the device description file. Use the same product
name as the entry used in the dialog box Add New Product in the
Product name field which appears under Product Details in the
product folder name.

= The product information is used in the device description file or has
effect in different Standard objects. Via the Standard objects, the
product information can be mapped to specific locations.

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
DOC1804040I01EN | Revision 1 | English | 2018-11 | Released | Public



IOT configuration 81/115

Example C100

[ Project Explorer & — @ Product Information [C100 (Application C100)] 2@—
B ~
+ @ netX 10T project © Product Information @

> = Object Model

- B Communication Settings Product Type

4 & Product Details

4 B C100 (Application C100) Product name’ Product Name
@ Product Information Product ID: 1000
B Product Macros

> = Vendor Details Product type COMX

> #4 User Management Order ID 2000

> (= Product Build Frofile I 3000
Profile type Standard
Product Version
Product revision: V1.0.00
Hardware name: C100
Hardware version:  y1.0.0.0
Software name C100
Software version: V1.0.0.0
Bootloader name:  ¢100 BSL
Bootloader version:  y1.0.0.0

4 n (2
F -
Figure 73:
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5.6 Entering vendor information

Vendor Information

The vendor information is identical in the overall project and for all devices.

» To enter the vendor information, in the Project Explorer window,
double-click on the folder Vendor Details > Vendor Information.

2 The Vendor Information editor (on the right side) appears.

5%
4+ @ netX_IOT project B Vendor Information @
- = Object Model
> Bs Communication Settings Product Vendor
& Product Details
« = Vendor Details Vendor name Mendor Name
B Vendor Information Vendor address
B Vendor ID ) )
> ¢4 User Management Vendor phone
> 22 Web Builder Vendor URL
Figure 74: Vendor Details > Vendor Information.
In the table below, you can see, which entries in the Product Information
editor are set in which reference object in in the Project Explorer under the
Object Model > Object Definitions > Standard > Generic folder.
Herstellerinformati | Max. Character type |netPROXY object CIP
on number of object
character
s
Vendor name 64 Printable ASCIl |0x10001000, [Device] Hilscher -
string; Element O VendName Gesellschaft fuer
only the Systemautomation
following mbH
Vendor address 128 ChafaCt‘?rS are  {0x10001000, [Device] Rheinstrasse 15, -
allowed: 32 Element 1 VendAddresse  |D-65795
Eggg)) ... 126 Hattersheim
Vendor phone 64 0x10001000, [Device] +49(0)6190/9907-0 -
Element 2 VendPhone
Vendor URL 64 0x10001000, [Device] http:// -
Element 3 VendURL www.hilscher.com
Table 22: Vendor Information (example)
To configure the vendor information, proceed as follows:
» Under Vendor Name (mandatory field), type the manufacturer's name.
» Under Vendor address, Vendor phone and Vendor URL enter the
address, phone number and web address.
= The data appear in the Vendor Information editor.
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Vendor ID
The vendor ID you must specify separately for each communication
system.

» To enter the vendor ID, in the Project Explorer window, right-click on
the Vendor Details > Vendor ID folder.

2 The Vendor Information editor appears.

[t5 Project Explorer 2 E Vendor ID 22
Sl
4 [ netX_IOT_project E Vendor ID ®
g : gbject Modet\ Sett Protocol # \endor ID
b ommunication Settings
& Product Details Etﬂhgrlt‘:estﬂg op 1
4 & Vendor Detalls
B Vendor Information PROFINET IO !
E Vendor ID EtherCAT 1
» 22 User Management CANopen 1
» & Web Builder DeviceNet 1
Open Modbus/TCP 1
Modbus RTU 1
POWERLINK 1
CC-Link 1
SERCOS I 1

Figure 75: Vendor Details > VVendor ID (example with vendor identifiers of the Hilscher
company)

Note:
You need your own vendor identifiers (ODVA)!

» In the Vendor IDcolumn enter your vendor identifier for the
communication systems used in your project.
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5.7 Configuring user managment

=%
s [ netX_|IOT_project
> = Object Model
> B Communication Settings
& Product Details
» &= Vendor Details
a &2 User Management
E User Accounts
B Group Access Matrix

-

Under User Management in you can complete the scope of functions of
your device by user names and roles for the user management at the
WebServer or the FTP server for your device. You can also view an
overview of the distribution of access rights to your device for the
WebServer or FTP server. The settings for user administration are stored
during the build process in the configuration file security.cfg. The set names
and roles for the roles Administrator, Supervisor and User can be used at
the WebServer or the FTP server.

» To create an account, in the Project Explorer window double-click on
the User Management > User Accounts folder.

2 The User Accounts editor appears.

[ Project Explorer 2 “& User Accounts 2

B User Accounts @)
User Name Administrator  Supervisor User m
(admmin o~ ] | |

Edit

> @i Web Builder

Figure 76: User Management - User Accounts editor
Action Meaning
[ pgd | Via Add you can add a new user account.
Via Remove you can remove a user account.
[ F ] Via Edit you can edit a user account.
Table 23: Control of the User Accounts editor
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User account for default administrator

The user account for the administrator is pre-configured by default. This
account can not be deleted. The administrator password can be individually

configured.

) Note:
. Change the default password for the administrator.

» Click Edit.
2 The User Accounts dialog appears.

Edit user account details

Specify details about this user account.

User name: * admin

Password: *

User role: ™ Administrator
Supervisor
User

Figure 77: User account Admin edited

» Check View password*, to see the password.

» Adapt the password in the Password* field and leave the dialog with

OK.
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Create user accounts

You can create user accounts for the roles Administrator, Supervisor and
User. In addition to the default user account "admin" you can create
additional user accounts for additional administrators.

» Click Add.

2 The User Accounts dialog appears.

x User Accounts

Add User Account

Specify details about the new user account.

User name: *
Password: *

[ View password

User role:* || Administrator
[T Supervisor
User

Cancel

Figure 78: User Accounts — add details to the new user account

Parameter Meaning Range of value/value

User name* User name (mandatory) String

Password* Passwort for the user (mandatory) String of uppercase and lowercase letters,
numbers and special characters

User role* Role of the user (mandatory) Administrator, Supervisor, User

A user can have only one role or several roles
in combination.

Default: User

Table 24: Details to the new user account

> In the User name* field, enter a username.

» In the Password* field, enter a password for the user.

> Under User role* check, which role or which roles the user shall have.

x User Accounts

Add User Account

Specify details about the new user account.

x

User name: * Linda
Password:*  ssase

|| View password

User role: *

Figure 79: Create a new user account (example)

» Exit the user account dialog every time via OK.

= In the User Accounts editor, the names and details of the specified roles

appear.
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Group Access Matrix

» To open the overview of the distribution of the access rights for the
WebServer or FTP server, in the Project Explorer window, double-click
on the folder User Management > Group Access Matrix.

= The Group Access Matrix editor appears. Therin you see an overview of
the roles and rights at the WebServer and the FTP server.

& Prject Explorer " GroupAccess M+ ]

B ~
4 @ netX_IOT_project E Group Access Matrix @

> B Object Model

p tion Set Application Administrator Supervisor User Anonymous
v & Communica |.0n etngs Web Server Administrative tasks. ~ Change device Device diagnosis. Read start page.,
& Product Detglls configuration. type label page and
» & Vendor Details status information.
4% Uhser Management FTP Server Read and write —- Read folder and files.  —
B UserAccounts folder and files.
| B Group Access Matrix|
£ Web Builder
Figure 80: Overview of the distribution of the access rights for the WebServer or FTP server
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5.8 Creating and managing web content

refer to the application note, netX Studio Engineering Tool, Web

For information about creation and management of web content,
Builder [6].

5.9 Generating product files

In the build process the product files are created, including the
configuration file, or the files for the object configuration, plus web content
files and the header files. The product files include the configuration
(definition of objects) and any additional settings (scope of functions,
communication, product details, vendor information).

A firmware image file can be created via the export function of . See section
Creating firmware image. The firmware image file contains the individual
files from the build process, without the header files, but in addition the

second-stage boot loader (SSBL).

5.9.1 Build process

Start build process

After you have finished the object definition and added settings and data for
your products, you can start the build process.

» For this select in Project > Build.

File Edit View Project Window Help

a (1 netX_|OT _project
¢ B Object Model
> e Communication Settings

Figure 81: Start device creation process (build process)
2 For seconds, a dialog appears which displays the progress.

Buikting Workspace - B x

i Building all..

| Building all... |

Invoking "Web Builder Project Builder' on /Web Builder',

|| Aways run in background

Figure 82: Running build process

= The Product Build folder with the subfolders Application Interface
and Products appears in the Project Explorer.

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
DOC1804040I01EN | Revision 1 | English | 2018-11 | Released | Public



IOT configuration

89/115

Directory Product Build with the generated product files

[ Project Explorer & BES - -

4 [ netX_|OT_project
» B Object Model
- B Communication Settings
> & Product Details
» &= Vendor Details
> &% User Management
> & Web Builder
4 (= Product Build
4 = Application Interface
4 (= Application C100
|2 Objects.h
4 (= Products
4 |(= C100 (Application C100)
4 (= netPROXY
84 config.nxd
2 npxmeta jsn
= websrv jsn
4 (= Security
2 security.cfg
4 (= Web Builder
|2 content.tar

Figure 83: Directory Product Build

Folder | File name | Description
Application Interface subfolder
Header file | Objects.h | Definition of user-specific objects for C programming
Products subfolder
netPROXY config.nxd File for netPROXY object configuration (objects, OPC UA server
parameters or MQTT client parameters)
npxmeta.jsn File with meta information
npxopcu.jsn File with object parameters for OPC UA
websrv.jsn File with WebServer object list
Security security.cfg Configuration file with content for user management on the FTP
server respectively on the WebServer
Web Builder content.tar Pack file with web content for the WebServer (optional)

Table 25: Product files in the build process of netX Studio Engineering Tool

e The Application Interface folder contains a folder for each application
variant, in which the header file Objects.h is located. Double-click the

file to open it.
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Datei Bearbeiten Format  Ansicht 2

copyright (c) Hilscher ambH., A1l rRights reserved.

i s e v e el o o o i o sl o el o e oo el el e o el ol e e e o el e e el

Filename:
$1dS

Last Modification:
$author§
$Date$
$revision3

Description:
automatically generated data types for netx_IOT_project - application €100

changes :

version Date Author Description
\'l\'r\'tﬁﬂ\'l\'t\'r\'rﬁﬁ\'r\'r\'rﬁﬂ\'r\'rn'rﬁﬁ\'!\'t\'rﬁﬂ\'r\'r\'rftﬂ‘il\'r\'rn'rﬁD\'r\'r\'rﬁﬁ\'l'\'r\'rﬁﬁ'\'l\'r\'tﬁﬂ\'l\'t\'r\'riﬁ\'r\'r\'rﬁﬁ\'r\?\?ﬁ'ﬁv\?\?ﬁﬁ\"\?\?\?ﬂﬁ\?\?\?ﬁﬁ\?\?l‘f
#ifndef __OBIECTS_H__
#define __OBJECTS_H__
#include <stdint.h= )
#include “Hil_Compiler.h’

#define COUNTER_ID 0x40010001
#define PARAMETER_ID Ox4 0020001

i

* ‘brief counter
* WSTruct COUNTER_T
-

typedef struct COUNTER_Ttag

uint32_t counterl; /#l< Counterl */
uint32_t counter2; /¥l< Counter2 */

} COUNTER_T;
"

* ‘brief Parameter
# WSTruct PARAMETER_T
®

typedef STruct PARAMETER_TTag

uint32_t parameterl; /*!< parameterl */
uint32_t parameterz; J*1< parameter2 ¥/

} PARAMETER_T;

i

* ‘\brief DPM Input Area
* \sSTruct DPM_INPUT_AREA_T
o

typedef _ HIL_PACKED_PRE STruct DPM_INPUT_AREA_TTag

b __HIL_PACKED_POST DPM_INPUT_AREA_T;

e

= “brief DPM Output Area
* WSTruct DPM_OUTPUT_AREA_T
N

typedef _HIL_PACKED_PRE STruct DPM_OUTPUT_AREA_TTAag

HIL_PACKED_POST DPM_OUTPUT_AREA_T;

#endif /¥ __ OBIECTS_M__ %/

Figure 84: Example, Header file Objects.h

9 Note:
. The header file objects.h contains only objects from the Object ID
range 0x4xxxxxxx (see section Object IDs [ page 107]).

e Below the folder Products there is a subfolder for each device with a
name of the application variant with the further subfolders netPROXY,
Security and Web Builder.

— The subfolder netPROXY contains the file config.nxd with the
object configuration and the communication settings for the
corresponding device, and the file npxmeta.jsn with meta
information, as well as the file websrv.jsn with the WebServer
object list.

— The subfolder Security contains the file security.cfg with settings for
the user management.
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— The subfolder Web Builder contains the file content.tar with content
for the WebServer for the corresponding device.

Clean - eliminate build process problems

Using the Clean option, you can eliminate build process problems and
rebuild a project build from scratch.

» Click Project > Clean.

2 The Clean dialog appears.

Clean will discard all build preblems and built states. The next time a build occurs
the projects will be rebuilt from scratch.

@) Clean all projects (2) Clean projects selected below

Ll netk_I0T_project
& User Management
& Web Builder

uild only the selected projects

Figure 85: Project > Clean

¢ In the Build dialog, you can configure whether all projects should be
cleaned (Clean all projects) or only certain projects which you have
selected (Clean projects selected below).

e In addition, you can configure whether to start a new build process
immediately (Start a build immediatelly) and, if so, whether the build
process shall be performed for all projects (Build the entire workspace)
or only for selected projects (Build only the selected projects ).
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5.9.2 Copy, remove product files

Open the Windows directory with product files
» Right click in on Product Build.
2> The context menu Show in Windows Explorer appears.

4 |= Product Bnild
- = Applica B Show in Windows Explorer
» (= Produc I Copy Ctrl+C
3¢ Remove Delete

Figure 86: Context menu Product Build > Show in Windows Explorer, Copy, Remove

» Click on Show in Windows Explorer.

2 The Windows Explorer with the Product Build folder opens. The
product files can be found in the subdirectories Application Interface
and Products.

4 | Product Build
4 | Application Interface
. Application C100
4 | Products
= L C100 (Application C100)

Figure 87: Folder Product Build, subdirectories Application Interface and Products

Copy, remove product files

(5 Project Explorer 2

4 [ netX_|OT _project
- = Object Model
> Communication Settings
> Bs Product Details
: & Vendor Details
> &% User Management
> £ Web Builder
4 (= Product Build

> (= Application Interface
4 = Products
a (= C100 {(Application C100})
4 (= netPROXY
3¢ config.nx

2 npxmeta Sz MO

2 websrv js # Remove  Delete
= -

> (= Security
» (= Web Builder

Figure 88: Context menu commands Copy, Remove

» UsingCopy, you can copy a subdirectory or a file from the Product Build
directory and place it in Windows Explorer.

» Use Remove to remove a subdirectory or file from the Product Build
directory.
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5.9.3 Meaning of the product files

The product files created in the build process are individual files, wherein
the object definition and the device configuration and all settings for the
device are included.

File File name Description

Header file Objects.h Contains information for application developers on which objects are
present in the device and how to access the objects.

net PROXY object config.nxd This includes the configuration information for the object definition with

configuration the definition of the device properties and the specifications on the object
instances for the scope of functions of the devices, and the
communication settings.

npxmeta.jsn File with meta information

npxopcu.jsn

File with object parameters for OPC UA

websrv.jsn

File with WebServer object list

User management

Security.cfg

Configuration file with content for user management on the FTP server
respectively on the WebServer

Web content (optional)

Content.tar

Pack file with web content for the WebServer (including corporate logos,
counters, etc.); finds application in Ethernet systems

Table 26: Product files of the build process
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5.10 Downloading product files

All files created during the product build under Product (Application) (see
table Product files in the build process of netX Studio Engineering

Tool [ page 89]) must be transferred to the device. Each file must be
downloaded individually.

) Note:

. During a product build, not all the files listed in the table Product
files in the build process of netX Studio Engineering
Tool [ page 89] are created in every case.

To transfer the files to the device, proceed as follows:
» Right-click on Product Build and select Show in Windows Explorer.

» Using netHOST.exe or the host application, transfer all product files
created during the product build under Product Build > Products >
Product (Application) to the device one by one.

Details about the netHOST user interface or the host application
D:ﬂ can be found in the corresponding software manual.

0 Important:

After all product files created during product build under Product
Build > Products > Product (Application) have been loaded into
the device, a device reset is required.

» After downloading the product files, perform a device reset.

= Your device is then prepared. This means that the device can be
accessed with OPC UA, MQTT or the web browser.
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6

Import, Export

includes import and export functions which you can use for various
purposes. The following sections provide more details about.

You can call the dialogs on the import and export functions at various
positions in the user interface.

o General on File > Import ... or File > Export ...
¢ In the Project Explorer window via a right-click on the project folder

o After executing the Build function by right-clicking on one of the product
files (objects.h, config.dat, security.cfg etc.) which are located in
subdirectories of the Product Build folder.

6.1 Import
About the import function in you can import the from an existing project
exported object definitions to one or several new projects.
The descriptions on how to proceed you will find here below.
Note:
Before importing, it is recommended that you save an existing
object definition by exporting it (see section Export [ page 100]) to
avoid accidental overwriting of object definitions.
Open the import dialog and specify import content
» In the Project Explorer window, right-click on the project folder.
[5 Project Explorer & ES ~—- =
4 | netX_|IOT_projert
> Bs Object Mod  New ;
> = Communic Open Project/Solution
> B Product De  Close Solution
> & Vendor Det i .
» s User Manag Build Project
> & Web Builde 3€Delete Delete
> = Product By  Rename F2
+ | Refresh F5
g Export...
Properties Alt+Enter
Figure 89: Call import function (example)
» Click Import ... .
2 The Import(Select) window appears.
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x Import - O x
Select
iEh
Select an import source:
type filter text
= General
& (= Install
a (= netd Studio
| ® Import Object Definitions |
@ bt
Figure 90: Specify import content (example)
Parameter Meaning Range of value /

value

Select an import
source

A display window with a folder structure for selecting the import
content.

Relevant is the folder netX Studio. The other folders are not
relevant.

In netlX Studio folder, you can specify the import content:
o Import Object Definitions (object definitions)

General, Install, netX Studio
Default: folder netX Studio

Filter [type filter text]

Field for typing a filter text to select a subfolder.

Table 27: Notes to the Import (Select) window
» Select the folder netX Studio.

» Select Import Object Definitions and click Next >.
2 The Object Definitions import window appears.

T - B X
Object Definitions Import
3 Provide an existing import file,
B User Object Definitions
®

Figure 91: Select import file
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Parameter Meaning Range of value /
value
Import file Displays after selecting the import file the path to the selected file
(mandatory) with the object definitions inclusively the name of the zip file.
[ provse... | Via Browse ..., the import file can be selected with the object *zip, e. g. User.zip
definitions *.zip (e. g., User.zip).
User Object If only the folder 'UserObject Definitions' appears, an export file Folder 'User Object
Definitions with any object categories and object definitions can be imported. |Definitions', or folders of

If other folders of object categories appear under the 'User Object
Definitions' folder, and you select one of these folders, you must
pay attention to warnings so that you do not inadvertently overwrite
object definitions.

subordinate object
categories

Errors (optional)

If you try to replace a folder of an object category with an import
file with object definitions, some of the object definitions to be
imported already exist in another object category of the project, the
error message appears:

Can not import object with ID 0x4XXXXXXX because such an
object exists outside of the destination category.

In this case, select another folder, for example 'User Object
Definitions', or import only object definitions that occur in the
project not yet outside the target category.

Table 28: Note to the window Object Definitions import
» Click Browse....
2 The Open window appears.

B ocen

v |4 £

ssed (zipp 3KB| ~

] [

File name: User.zip

~ | Zip files (*zip) -

Figure 92: File selection dialog for import file (example User.zip)

» Select the import file with the object definitions (e.g. User.zip) and click

Open.

2 The path to the selected file with the object definitions (e. g. User.zip) is
displayed in the window Import Object Definitions.
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Import Qbject Definitions - B X
Object Definitions Import
Select a file to import.

Import file: * "User.zip m

4 & User Object Definitions

@

Figure 93: Import file selected (example User.zip)

[ Project Explorer &2 BES - - &

4 [ netX_|OT_project
4 B Object Model
4 & Object Definitions
4 B User
4|Bs Parameter [0x40020001 - 0x40020010]
@ 0x40020001 Parameter [1.0]
4 B Status [0x40010001 - 0x40010010]
- @ 0x40010001 Counter [1.0]
> & Standard
» B Object Instances
&= Communication Settings
& Product Details
&= Vendor Details
22 User Management
# Web Builder

Figure 94: Newly imported object definitions (example)

v v v v v

» In the Import Object Definitions window click Finish.
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Warning: Object category will be overwritten

Object Definitions Import

(v, The structure of category "User” will be overwritten,

Import file:*  C:\Users\ ™ I\Userzip @

. &5 User Object Definitions
& Parameter [0:40020001 - 0:40020010]
B Status [0:40010001 - 0:40010010]

@ i
Figure 95: Import file selected (example User.zip) - Warning, category "User" will be
overwritten
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6.2 Export
Using the export function in you can
o export the object definitions of an existing project (in order to be able to
import them subsequently to one or several new projects)
e the project documentation of a project.
The descriptions on the procedure in detail, you find in the following
sections.
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6.2.1 Exporting object definitions

In the dialog for exporting the object definitions (Export Object Definitions),
you specify the output folder for the file containing the object definitions.
Proceed as follows:

Openl Export dialog and define export content
» In the Project Explorer window, right-click on the project folder.

[(5 Project Explorer &2 EBES ~—- =
nF, == = 1
4| netX 1P N
b Obj

B Co Open Project/5olution
Bs Prg  CloseSelution

[+
[+
b & Ver  Build Project
[+
[+
[+

28 Use
& We 3 Delete Delete
- Rename F2
Pro
& | Refresh F3
pag Impoert..
Properties Alt+Enter

Figure 96: Call Export function (example)

» Click Export ....
2 The Export window (Select) appears.

= Export - B
Select ﬂ
Select an export destination:
type filter text
= General
= Install
a (= netd Studio

| ® Export Object Definitions |
Export Project Description

@ Nes-

Figure 97: Define export content - Export Object Definitions
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Parameter

Meaning

Range of value /
value

Select an export
destination

Display window with a folder structure for selecting the export
content.

Relevant is the folder netX Studio. The other folders are not
relevant.

In netX Studio folder, you can specify the export content:
e Export Object Definitions (object definitions),

e Export Project Description (project documentation)

General, Install, netX Studio
Default: folder netX Studio

Filter [type filter text]

Field for typing a filter text to select an export function.

Table 29: Notes to the Export (Select) window
» Select the folder netX Studio.

» Select Export Object Definitions and click Next >.
2 The Export Object Definitions window appears.

Set output folder for the file containing the object definitions

[E— -~ o x
Export Object Definitions

(1) The export of category "User" will create "C:\Users\. IUser.zip".

Destination folder: = C:\Users\

a |B5 User Object Definitions |
B Parameter [0x40020001 - 0x40020010]
& Status [0x40010001 - 0:40010010]

Figure 98: Set output folder

Parameter Meaning Range of value /
value

Export Object Instruction texts:

Definitions

Provide an existing destination folder.

The export of category ,XXX* will create [path and export file
name].

Destination folder*
(mandatory)

Shows after the selection the path to the current output folder for
the export file with the object definitions.

Via Browse ..., an output folder for the export file with the object
definitions can be changed or can be created newly (by default on

your PC).

C:\User\[user name]

Table 30: Notes to the window Export Object Definitions

» Via Browse ... you can search for the output folder or create a new

output folder.
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———

Bl Desktop

* = Bibliotheken
gl -}

Ll Cormputer

» ﬁh Metzwerk

Ordner: =

Meuen Crdner erstellen ]

Figure 99: Search folder

» Select the path and click OK.
» In the Export Object Definitions window, click Finish.

= The file with the object definitions (e. g. User.zip) is stored in the
selected storage location. In case the same storage location is used
more than once, no query appears if you want to overwrite the file with
the object definitions.

6.2.2 Exporting project descriptions

In the dialog for exporting the project descriptions (Export Project
Description), you specify the content for the project documentation and the
output folder. Proceed as follows:

Open Export dialog and define export content
» In the Project Explorer window, right-click on the project folder.

[t5 Project Explorer BES ~— =
nk, ==
4|l netX_| New N
> B Obj

: s Co Open Project/Solution
> B Pro Close Solution

> & Ver  puild Project

> &2 Use
. & We 3 Delete Delete
Rename F2
* 5 PIO - Refresh F5
pagImport...
Properties Alt+Enter

Figure 100: Call Export function (example)

» Click Export ....
2 The Export window (Select) appears.

netX Studio Engineering Tooll | IOT Configuration © Hilscher 2018 — 2018
DOC1804040I01EN | Revision 1 | English | 2018-11 | Released | Public



Import, Export 104/115
x Export - O bad
Select ﬂ
Select an export destination:
type filter text
> (= General
> (= Install
a (= netX Studio
# Export Object Definitions
|E Export Project Description |
® =
Figure 101: Define export content - Export Project Description
Parameter Meaning Range of value /

value

Select an export
destination

Display window with a folder structure for selecting the export
content.

Relevant is the folder netX Studio. The other folders are not
relevant.

In netX Studio folder, you can specify the export content:
e Export Object Definitions (object definitions),
e Export Project Description (project documentation)

General, Install, netX Studio
Default: folder netX Studio

Filter [type filter text]

Field for typing a filter text to select a subfolder.

Table 31: Notes to the Export (Select) window
» Select the folder netX Studio.

» Select Export Object Definitions and click Next >.
> The Export Project Description (Select products to export and

destination folder) window appears.
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Specify content for the project documentation

Export Project Description
Select the exported contents and destination felder.

Destination folder: *  C:'\Users\Mechthild

4 [H B Object Model
[ B Object Definitions
a4 [¥| B Object Instances
Bs Application C100
4 & Communication Settings
E& Application C100
P B Product Details
&= C100 (Application C100)
Bs Vendor Details

Open the exported HTML documentation in browser

Figure 102: Specify content for the project documentation and output folder

Parameter Meaning Range of value /
value

File system Instruction texts: Select projects to export and destination folder.

Destination Folder* Displays the path to the current output folder for the file with the

(mandatory) project documentation. The file name [Project name].html (in the
example series B.html) and cannot be adapted here.

S Via Browse ..., an output folder for the file with the project C:\Usen\[user name]
documentation can be selected or can be created newly (by default
on your PC).

Selection dialog for | The selection dialog includes the total project content,
the project content o the Object Model,

e to the Communication Settings,

e to the Product Details,
¢ to the Vendor Details and
By default, except the object definitions, but these can be selected

manually.
Open the exported The exported project documentation will be displayed directly in a | Checked, unchecked,
HTML documentation [browser after each export. Default: checked
in browser
Table 32: Notes to the window Export Project Description
» Click Finish.
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= The project documentation appears in your browser.

The project documentation includes all in the selection dialog selected
project content. By scrolling in the browser, you can view all content.

Project : netX TOT_project

0x40010001 Status

Object Model
Object Instances

Application C100

Name Variable name Data type Value Attributes Description
Countert countert uintz2 [ Hone
Counter2 counterZ uintz2 ‘ o Hone ‘ ‘
0x40020001 Parameter
Name Variable name Data type Value Attributes Description
Parameter! parameter1 uintz2 0 Hone
Parameter2 ‘ parameter2 ‘ uintz2 ‘ 0 | None |
Communication Settings
Application C100
Product Details
C100 (Application C100)
Product Type
Product Name c100
Product D €100 (Application C100)
Product Type camx
Order D 2000
Profie D 3000
Frofie Type Standard

Product Version

Property

Value

Product Revision V1.0.0.0
Hardware Name c100
Hardware Version V1.0.0.0
Software Name €100
Software Version V1.0.0.0
Bootioader Name. €100_BSL
Bootloader Version V1.0.0.0

=
=
5
]
8
a

Macros

Vendor Information

Property

Expands to...

Vendor Details

Value

Wendor Name

Wendor Name

Vendor Address

Wendor Phone.

Vendor URL

Vendor ID Table
Protocol

EtherNetIP

Vender ID

PROFIBUS DP

PROFINET IO

EtherCAT

CANopen

Devicellet

Open Modbus/TCP

Modbus RTU

POWERLINK

€C-Link

SERCOS Il

Figure 103

: Detail product documentation in HTML
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7 Appendix

7.1 Reference data for netPROXY

7.1.1 Object IDs

The following summary table lists the defined value ranges for objects,
which play a role in the use of the object-oriented data structuring with
netPROXY with the device development tool and must be distinguished or
which Object IDs are used by in the ranges 0 to 3.

From the user in created objects are always in object ID area. 4

Range of value Name of the range Note

object ID

O0XO0XXX XXXX netPROXY e. g. directory, event log etc. in
(without 0x0000

0000)

OXTXXX XXXX System e. g. general services. These include

among others objects that have been
created in under Product Details.

OX2XXX XXXX

Communication protocol

Object ID range that is reserved for
objects of the communication protocol.

OXFXxxx Xxxx

OX3XXX XXXX Hilscher Objects created by Hilscher,
e. g. Host interface, peripherals, etc.
OX4XXX XXXX User User-created objects in . These are
included in the objects.h file.
OX5XXX XXXX ... Reserved

Table 33: Fixed ranges of value for object IDs

For further information about the assignment of the Object ID
ranges listed in the table Fixed ranges of value for object

IDs [ page 107], refer to the manual Technical reference,

netPROXY, Objects and packages [2] (see section References).
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7.1.2 Element data type, size, number, limits
The following table Object element data types, size, number,
limits [ page 108] lists the for
e the in configurable elements valid element data types,
¢ the related netPROXY data types,
¢ the size for each data type in bytes
¢ the maximum number of data types per element for each data type and
¢ the minimum and the maximum number of viewable values for each
data type.
The default value for all numeric data types is 0.
The default length for all numeric data types is 1 (0 is not allowed).
A "string" has an empty string as default value. The default length "string" is
255 bytes.
netX Studio | netPROXY data types Size in | Max. Minimum number of Maximum number of
Element bytes [number of |viewable values viewable values
data types data types =
Max.
Default
value
boolean NPX_TYPE_BOOLEAN 1 1 0 255
uint8 NPX_TYPE_UNSIGNED |1 1 0 255
uint16 NPX_TYPE_UNSIGNED |2 1 0 65535
uint32 NPX_TYPE_UNSIGNED (4 1 0 4294967295
uint64 NPX_TYPE_UNSIGNED |8 1 0 1,84467E+19
int8 NPX_TYPE_INTEGER 1 1 -128 127
int16 NPX_TYPE_INTEGER 2 1 -32768 32767
int32 NPX_TYPE_INTEGER 4 1 -2,147,483,648 2,147,483,647
int64 NPX_TYPE_INTEGER 8 1 -9,223,372,036,854,775,8 | 9,223,372,036,854,775,8
08 07
real32 NPX_TYPE_REAL 4 1 -3.4E+38 (7 digits) +3.4E+38 (7 digits)
real64 NPX_TYPE_REAL 8 1 -1.8E+308 (15 digits) 1.8E+308 (15 digits)
string NPX_TYPE_STRING varies | 1540 - -

Table 34: Object element data types, size, number, limits
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MQTT

netPROXY

netX

OPC UA

Second Stage Boot
Loader

WebServer

Glossary

Message Queue Telemetry Transport: publish-subscribe based "light
weight" M2M (machine to machine) messaging protocol for use on
top of the TCP/IP protocol and for telemetry data transmission with a
very low footprint. As protocol of the Internet of Things (loT) it is
standardized by OASIS (Organization for the Advancement of
Structured Information Standards) since 2013. Additional features:
ease of use, efficient use of resources, security mechanisms, support
of several cloud-systems, session-aware, data-agnostic (i.e. flexible
structures allow to transmit multiple types of information

Application framework for efficient development of networked devices
based on Hilscher netX. It provides an object model as a generic
abstraction for services or data. The term is also used as a general
term related to the netPROXY technology of Hilscher.

networX on chip, Hilscher network communication controller. High
integrated network controller with optimized system architecture for
communication and maximum data transfer.

OPC Unified Architecture: industrial M2M (machine to machine)
communication protocol developed by the OPC Foundation for
interoperability, with a cross-platform service oriented architecture
(SOA) for process control, while enhancing security and providing an
information model

started by the netX ROM loader, it creates a standard Hilscher dual-
port memory and offers basic functionalities. It enables the download
of firmware files via the dual-port memory.

Firmware subset of a device developed according to the netPROXY
model and allows the user in the field among other things, using a
standard web browser and Ethernet interface, to retrieve status
parameters from the automation device, to perform a firmware update
or to reset the device via HTTP and optionally to read and write data
or to configure the IP address of the device.
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